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Introduction
PrintSuperVision (referred to as PSV throughout this document) is a Windows server
application designed for managing and monitoring printing and copying devices. The core
application is server–based and is accessible from any browser enabled device connected
to a network. Popular browsers supported include Internet Explorer, Firefox, Chrome and
Safari.
The application is available in two editions: Professional Edition and Enterprise Edition.
The Professional Edition is a subset of the Enterprise edition and shares the same menu
structure and many of the same features. Notations will be made throughout this
document to indicate differences between the Enterprise and Professional Editions.
One notable feature in the Professional Edition that does not exist in the Enterprise Edition
is the Single-user “Easy Configuration” option. The Single-user option can be installed in
a non-server configuration on network-connected laptops and desktops.
The Single-user Easy Configuration option allows users to check status of supply levels,
monitor consumable life remaining and collect printed page counts while providing the
ability to order supplies on line. The easy configuration option is designed for very small
offices and does not support the automatic delivery of device Alerts through email.
Some of the common features of both PSV Professional and PSV Enterprise Editions
include:
 Discovers and configures devices
 Helps pinpoint devices on the network
 Assists in remote trouble shooting
 Automatically identifies device status and emails alerts
 Produces reports and automatically delivers them via email
 On-line supplies and consumable ordering (configurable by region)
 Manage devices including detailed job accounting reports
 Monitor locally connected OKI devices with PSV Agent, PSV Assistant
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What’s New in Version 4.0
Perhaps the most important enhancement in version 4.0 Enterprise Edition is the
accounting features that help manage Oki devices. When configured, this feature collects
detailed user and device job accounting data and provides reports. Using this feature,
print quotas can be set for users and enforced on the device. Users can now be managed
by synchronizing the list of users with Active Directory.
Several other noteworthy enhancements have been made to both PSV Pro and PSV
Enterprise Editions in version 4.0 and include:
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Windows 8 and Windows Server 2012 support added
Support for SQL Server 2008 Express R2 and SQL Server 2012 Express has been
added, allowing up to 10 GB of database storage.
“Device Job Logs” enhanced to show print job data for selected devices
Enhanced the file download feature to support remote firmware installation in
Enterprise Edition
“Configure Print Devices” feature in Enterprise Edition allows remote configuration
of a fleet of similar printing devices. The desired printer properties can be
configured in a CSV file and imported to PSV and the changes applied to the devices.
“Configure MFP Devices” feature in Enterprise Edition allows automation of scan
profiles, scan templates for select OKI printing devices
“Low Supplies Report” helps in replenishing the consumables of devices that are
running low
“Printing Report” in Enterprise Edition provides the number of color and mono
pages printed, and shows daily/monthly usage
Supplies Forecast Report added to provide a summary of projected consumables
replenishment within 90 days
SNMP Community Name supported for discovering devices. SNMP delay option is
added to allow discovering all devices in a slow network.
Enhancements to the User Interface to support better access from iPhone, iPad
browsers – changes made for easier navigation in those devices

Installing the Software
PSV Professional and Enterprise Editions are available from www.okidata.com at
http://www.okidata.com/printsupervision-downloads-and-faq.
Both Enterprise and Professional editions downloaded from the web include the PSV
Server application. PSV Enterprise also includes the PSV Director application described
later. The PSV Agent and PSV Assistant applications are available as separate downloads
from the web and operates only with PSV Enterprise.
During installation, PSV checks the target server to see if .NET 2.0 (or above) is installed.
If the .NET platform is not detected, PSV will link the user to the Microsoft website to
download and install the .NET software. PSV also provides the option to download and
install Microsoft’s free versions of SQL databases such as the Express Edition and Compact
Edition.
To install PrintSuperVision, locate the executable file that was downloaded from the Oki
website, and click on it. A standard licensing agreement is displayed. If you agree with
the license agreement, click Next.
Both editions allow you to select the desired components to install. The following dialog
box displays the options that can be installed in the Enterprise Edition. Fewer choices are
available from the same dialog box when installing the Professional edition.

An application called PSV Director can be installed along with the core server (web)
application and other options. PSV Director provides Windows domain administrators the
ability to remotely install, upgrade, uninstall, monitor, and configure the PSV Agent (which
is a separate download).
The Director can also collect information about printer queues, drivers, and ports on either
a single computer or all computers in a domain. PSV Director will be discussed in more
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detail in the Monitoring Locally Connected Devices section. Click the PSV Director
check box if you wish to install that module.
Note: When PSV Director is installed, you can find it later by clicking Start /All
Programs /PrintSuperVision. It is not accessible from the setup wizard discussed in
the following section.
You also have the option to install free versions of SQL Express or SQL Compact Editions
which PSV uses to collect device information and subsequently to run reports.
If you do not install SQL Express or SQL Compact edition you will still be able to use PSV’s
built-in Microsoft Access database but it is limited in storage capacity, so if you are
monitoring a large fleet we suggest using SQL Compact, SQL Express or a purchased
version of SQL.
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Setup and Configuration: Using the Setup Tool
Immediately following installation, the PSV setup tool (wizard) is launched. Follow the
step by step process to configure PrintSuperVision. Keep in mind that many of the
configuration options are also available from within the PSV server application so it is not
imperative to complete all configuration settings during the initial setup process.
You may also return to the PSV Setup Tool at any time. It is available from the Windows
Start menu by clicking All Programs / PrintSuperVision / PrintSuperVision Setup.
Note: Certain changes using the PSV setup tool can only be made when the web
application and PSV Engine services are not running. For example, in order to change the
web server component from “embedded” to “IIS”, the web service application must not
be running.

Selecting a Location/Language
The PSV setup tool launches directly into the Locale tab and displays the Region/
Language selection screen first.
1. Select a default region / language for all users
2. Click Apply and Next
Each user can later change his/her language preference directly from the application. Use
caution however when selecting the desired language since it is changed as soon as the
user clicks “Apply”.

Note: The region/language selected effects enabling or disabling the On-Line supplies
ordering feature in PSV. Selecting “North and South America” region will enable the OnLine ordering feature. Selecting any other region disables the ability to order supplies online from links that appear within the application.
10

Selecting a PSV Edition: Features Tab
After choosing a language and clicking Next you will be prompted to select the PSV
edition that you would like to use.
If you installed the Enterprise Edition you are offered the choice to install either the
Enterprise or Professional Edition (but not the single-user Easy edition).

Select the desired PSV configuration, Click Apply and Next.
If you installed the Professional edition you have the choice of selecting the Single-user
“Easy” edition or the standard server-based Professional edition. Select the appropriate
configuration and click Apply and then Next.
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Entering a Software License Key: Enterprise Edition Only
If you selected the Enterprise Edition you will be prompted to enter a valid license key.
Keys can be requested from Oki Data Customer Support via email at
psvlicensekey@okidata.com or by calling 800-okidata.
Enter a valid license key and Click OK

Selecting a Database: Database Tab
The next step is to select the type of database you would like to use with PrintSupervision.
As mentioned previously, both editions of PrintSuperVision utilize a built-in Microsoft
Access database, but you may choose other options as well.
If you do not wish to use the built-in Access database, PSV allows you to select SQL
Compact Edition (in the Pro edition) as well as SQL Server Express in the Enterprise
edition. Both versions of SQL were provided as optional choices when installing PSV
Enterprise.
While in the Database tab, Click the Setup tab and select the desired database from the
dropdown menu.
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Note: The previous Screen shot is from PSV Enterprise. PSV Professional does not
provide the option to enter a name for the server or database.
Also note that the SQL Server Tab is dynamic and will only appear if you have a full
version or express version of SQL server installed on the server/computer.
Click Apply, and the following options are presented:

Please note that even if you already have a compatible database such as SQL Compact
Edition installed on your server, you still must complete the following steps to “create” it
so that PSV knows where to save data.
Click one of the following options:




Migrate:
Change:
Create:

Migrates your current database to a new one
Switches to an existing database
Creates a new database

For new PSV Installations click Create which creates a new (empty) database.
To switch to an existing database without saving any previous data click Change.
To create a new database and copy existing data to the new database click Migrate.
Click Start to process the database selection and click OK when the operation is complete.
To restore PSV database generated by another instance of PSV, use the Restore option if
the database is SQL Express.
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If the requirement is to switch to a SQL server from SQL Express – when the database
size exceeds the SQL Express limit – the following steps are recommended:







Copy the SQL database to the SQL server
Ensure that SQL authentication is used and not Windows authentication if the
database is located in another computer
Run PSV Setup utility, and in the database tab, enter the name of the SQL server
and the database name
Click Apply to save the changes
The pop up screen with the 3 options – Create, Change, Migrate – will appear.
Select Change.
Note that if SQL server is used, to backup and restore the PSV database, use the
SQL management tools such as SQL Server Management Studio.

Notice in the Enterprise Edition (not available in Pro) that you may also test the
connection to the server and enter a new name for the server if you selected SQL Server
Express or another SQL database such SQL 2000, 2005, 2008, 2012 that have already
been installed on the server.
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Assigning server memory limits to SQL server: Database Tab:
If the server you are installing PSV on already has a full version (or express version) of
SQL installed, the SQL Server tab will appear in the Database section.

This tab allows you to assign a maximum amount of memory that SQL can use and may
prevent SQL from consuming a significant part of your server’s memory.
To check the amount of memory (RAM) that SQL is currently using, click the Get button.
A numeric value will be displayed. To allocate a larger or smaller amount of RAM to the
database application, type in an amount (in megabytes) in the Max Memory field and
click the Set button.
You may also click the Properties button to see the accumulated size of your database
files.
Note: The SQL Server tab is not available in the PSV Pro edition
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Database Housekeeping Features: Database Tab:
While in the database section, you may also click the Data Tab for several other database
“housekeeping” options such as backing up and restoring a database, exporting data,
erasing, copying, and trimming data from an existing database.

A noteworthy feature in the Data section is the Read Only Mode.
By checking the Read Only Mode box it prevents PSV from discovering devices. This is
particularly useful when a device database has been imported for diagnostic purposes and
you do not want PSV to discover those devices. But use caution and do not check the
Read Only Mode box for normal operation.
Perform the desired functions and click Next to move to the next setup module.
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Selecting a Web Server: Web Config Tab
PSV supports both Microsoft IIS web server and/or an Embedded Web Server that is
packaged with the PSV application. It is strongly recommended to use IIS if you will be
monitoring large networks with hundreds or thousands of devices. The embedded server
provides the same functionality as IIS but performance can be affected when using it in
large network installations.
If IIS is not installed on the target server/computer, it will not be visible in the Web
Server drop down box displayed below.

Select the desired web server from the drop down box and click Apply.
The server status box indicates whether the service is running, you also have the ability to
start it or stop it. Additionally there is an option to select how the web server should start:
automatically, manually or disabled. Make the desired settings and click Apply.
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Configuring an Internal Web Site: Web Config Tab
PSV provides an option to select a pre-defined web site rather than using the default web
site. When multiple web sites are created and configured in IIS, the website names will
appear in the website selection drop down box. Select the appropriate web site or use the
default if no web sites have been previously configured.
PSV also provides the option to use a unique virtual directory name or use the default
name, which is configured as "PrintSuperVision".
The Authentication option eliminates the need for an Admin to log in to PSV if they have
previously been authenticated on their domain. Select Windows Integrated
Authentication to take advantage of this time saving feature.
To require Admin log-in every time, keep the default setting which is PrintSupervision
Authentication.

Click Apply to save changes.
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Configuring a Public Web Site: Web Config Tab
The Public Web Site tab is only supported in PSV Enterprise edition and will appear only if
IIS is selected as the web server.
The Public Web Site feature allows you to create an intranet or internet site that can
receive data from multiple PSV server sites or from multiple PSV Agents. This can be
particularly helpful in retrieving device page counts and other supply status information
from one designated site rather than requiring users to access multiple PSV server sites.
An additional feature in PSV v4.0 allows you to change IP address configurations (on Oki
Devices only) from dynamic to static by using an intranet web page without the need to
access the core PSV server application. In this scenario, a technician, who does not have
PSV Admin rights can simply access an intranet web page rather than having to run a
standalone utility.
You must create the intranet web page by adding a Virtual Directory prior to entering
the virtual directory name and/or selecting the Configure Static IP Address check box
in the setup routine. A new virtual directory can be created from the IIS section in your
OS.

Note: This feature is intended for Intranet usage only, so if the PSV public website is
configured for public internet, the check box should not be selected.
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Assigning Admin Username and Password: Administrator Tab
Newly installed versions of PSV come with a single user account called “Admin” which has
all Administrator Access rights. It is strongly recommended to enter a new Username and
Password for the global Administrator.
The Global Administrator can later add other administrators or standard users from within
the application.

Click Apply after a new username and password have been created.
The Global administrator can reset the login password using the Setup utility.
If you selected Windows Integrated Authentication mode described in the last section,
the following screen will be displayed just for verification.

Click Next to go to the next setup module.
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Configuring your E-mail server: Alerts Tab
In order for PSV to send out device related alerts via email, you must first enter the
necessary information such as the address of your email server, username, password, the
email address of the recipient, etc.

Enter the desired Email Server Address and SMTP server port (default port number is 25
and 456 or 587 if using SSL/ TLS).
Select the appropriate email sending method. PSV provides 4 methods that define how
the email message is sent:
Method 1 – This is the Default setting. It uses a SMTP library from IP Works
Method 2 – Permits streaming. Emails are sent without buffering once the
connection is established
Method 3 – Uses Webmail library from .NET 1.1
Method 4 – Content of email is saved as a file attached to an email message
Method 1 is recommended, but you may try methods 2, 3 and 4 if emails are not
successfully sent using the default setting.
If your email server requires authentication, indicate the appropriate username and
password in the fields provided. Click the TLS / SSL checkbox if your organization uses
these communication protocols.
Enter the email address of the recipient in the Admin Email field.
As an added convenience, PSV allows you customize the header and subject line of all
email messages sent. Add the desired words to the “Email From” and “Email Subject”
fields or keep the defaults which are PrintSuperVision and Alerts.
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Indicate the interval time (in minutes) for PSV to wait to obtain device status. Set to a
larger number if network traffic is a concern. Set to a smaller number if you would like
more frequent updates reported from your print/copy devices.
Finally, another added convenience allows you to start and stop the PrintSuperVision
Service from the set up menu and select whether the PSV Services should start
automatically, manually or are disabled.
You can test the email connection by clicking the Test button (located next to the Admin
Email field). PSV will attempt to send an email message to the address you specified.
If an email is received successfully, click Apply to save your settings and click Next to go
to the next setup module.

Data Synchronization: Data Synch Tab
Making configuration settings in the Data Sync section are only required when multiple
PSV servers are installed and are configured to communicate with each other.

Disregard this section and click Next if you have a single PSV server /site that does not
communicate with any other PSV server.
Note: PSV Enterprise Edition can receive and send data while PSV Professional Edition can
only send data, therefore an Enterprise Edition must be designated as a receiving site.
Each PSV Enterprise server (site) can send and receive data which can help streamline the
reporting process by collecting and saving data in one central location. Thus an admin
may run reports from other PSV sites while being logged into one server designated as
the “receiving site”.
To receive data from other PSV sites, simply enter the name of the receiving PSV site in
the “Local Site Name” field. If no data will be sent from the receiving hub PSV site, leave
the Send Data to URL field blank.
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It is important that the Local Site Name is specified. If a name is not entered, data will
not be sent during data synchronization.
Each remote PSV site must also be configured to send data to the central hub PSV
receiving site. To do that, you must log into each remote PSV site, assign a local site
name as we just did, and indicate the address / URL of the receiving PSV site in the Send
Data to URL field.
The data synch feature also allows you to specify a proxy server should one be required to
connect to the PSV receiver site.
Keep the default setting checked “Use IE Connection Settings” if you would like the
proxy configuration to be fetched from the current user’s Internet Explorer configuration.
Otherwise, check the Use Proxy Server box and enter the appropriate proxy address and
port number.
Click Apply to save changes.
To schedule how often data synchronization should take place among PSV sites, click the
Schedule tab and enter the appropriate time and interval.
If no interval values are entered, PSV assigns a default value of 1 hour. The minimum
value is 1 hour and the maximum interval value is 24 hours.
Click Apply to save changes and click Next to proceed to the next section
Note: The ability to configure the Data Synchronization feature is also available from
within the PSV application and will be discussed later in this guide.
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Software Registration: Registration Tab
You can register your new PrintSuperVision software with Oki Data Americas on-line by
clicking the Register button.

Registering your name and email address with Oki Data will help us keep you informed of
new product releases and PSV related information. All registration information supplied is
kept in strict confidence.
Select the appropriate language / location to register. Enter your user information
including your email address and click Save.

A validation email will be sent to the email address indicated. Click the validation link in
the email message when you receive it and your information will be registered.
Back to the registration Process: If the PSV Setup tool is still running, click on the PSV
Setup tool icon in the tool bar to return to the Setup process. Click Next to go to the
next setup module.
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Identifying PSV Version Numbers: Program Tab
The Program tab is provided as a means to quickly identify the version numbers of each
major component in PrintSuperVision.

Click the Readme button to view the PSV Readme file, or
Click Back to return to a previous section, or
Click Run to complete the setup process and begin using the PSV application.
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Getting Started
Now that you have installed and initially configured PrintSuperVision, you may use any
browser-enabled computer or device connected to your network to access the PSV
application.
Open your browser and type the IP address of the PSV server followed by
/printsupervision. For example: http://12.34.56.78/printsupervision
If you are the Global Administrator or have Admin rights, click Login, and type your user
name and password. If you have not changed the login username and password, the
default is admin and password.

Context Sensitive Help
Throughout the PrintSuperVision application, help is just a click away. For context
sensitive help, click the
icon located in the upper right corner (next to the printer icon)
on every page.

User Access
One of the first things to determine is the level of access rights to assign to each user.
There are 3 ways a user can access the PSV application from any browser:




Without Logging into PSV
Logging in as a User
Logging in as an Administrator

Be aware that certain menu options are only available to users with Admin rights that
have logged into PSV. For example, in the following screenshot the user is not logged in:

In this example a user is logged in as an Administrator
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If a user does not log in, the areas that are not accessible are Services, Reports, and
Accounting and the following functionality will not be available





Cannot
Cannot
Cannot
Cannot

view, add, or configure Alerts
generate any type of report or configure email sending
add or delete devices or users
access accounting options including setting quota, obtaining device job logs

Adding a User / Assigning Individual User rights:
To add an individual user to the system:
1. Select Options from the main menu
2. Click Users from the drop down box
3. Click the Add User button and fill in the user’s information. Make sure that you
include a password that contains at least 6 digits.
4. Before clicking Save, assign the appropriate user rights by Selecting
Administrator from the Add to Group drop-down box or leave it blank for
Standard User rights.
5. Click Save
A list of users will be displayed. Notice that individuals with Admin rights are displayed
with a red line under the icon while those with Standard User rights are displayed with a
blue line under the icon.
Note: User attributes can be changed at any time by clicking the icon in the Edit column
and entering new information.

Importing a List of Users
It may also be helpful to take advantage of the Import Users feature to save time. You
can import users into the application from a text file using a comma separated format.
The fields available for data import are the same fields listed in the Add User section.
Fields cannot be left empty with the exception of Password. If passwords are not
supplied in the text file, PSV will set it to the word “password” by default.
To import a list of users:
1.
2.
3.
4.
5.

From the main menu click Options
Select Users
Select the Import Users button
Specify the text file location or click Browse to locate the file
Click the Import Users button.

PSV will add users one by one into the application. When complete, the number of users
imported successfully will be displayed as well as details of any errors that may have
occurred.
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Creating User Groups:
In large organizations it may be helpful to organize users into groups based on admin
status, user status or by any number of criteria. This feature should not be confused with
creating groups of print devices which is also possible in PSV and described in the next
section.
To create a group of users:
1.
2.
3.
4.
5.
6.

Click your browser’s back button or select Options from the main menu
Select User from the drop down box.
Click the User Groups button
Click the Add User Group button
Enter a name for the user group
Click Save. A list of groups will be displayed.

You will notice that the new group name is automatically added to the Add to Group drop
down menu when adding an individual user.
For convenience, the All Users button has been provided in the User Groups area to
help identify if an individual has been assigned to a group.

Changing Your Password:
1. Select Options from the main menu
2. Click Change Password
3. Enter your current password, then enter your new password and confirm the new
password by typing it again
4. Click Change to save new password

Creating / Editing Groups of Devices:
Before discovering the devices on your network, it may be beneficial to organize them into
logical groups in order to monitor and manage them in an efficient manner.


A Group can have attributes assigned to it such as location, contact person, SNMP
community and even images of maps and floor plans which are used to quickly
locate individual devices



Groups can be arranged in a hierarchy where a “parent group” can contain sub
groups. A device can also be a member of more than one group



You can assign a subnet or a range of IP addresses (for discovery purposes) to a
group, and as an added convenience, a link to the discovery screen is provided
when groups are displayed.

To create or edit a Group:

1. Click Printers from the main menu and Printer Groups, Maps from the drop down
menu to view a list of groups already created.
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2. Click the Add Group/Map button to create a new group of devices

3. Assign a Parent group, a group name, location, contact person responsible for the

group, a map or floor plan and the SNMP community name. If Model Names are
entered in the Models in Group field, the group will be populated with the model
names that match. Whenever a new device is discovered or added to PSV that
matches the model name, that device will be added to the group.

4. Click the Save button
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Adding/Removing a Device to/from a Group:
To add a device to an existing Group

1. Click Printers from the main menu and Printer Groups, Maps from the drop down
menu view a list of groups already created

2. Click Edit in the Edit Column of the group you wish to modify.

3. Click Add Printer

4. Select the appropriate device from the Printer drop down menu and click Save
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If the group was initially empty, you will see the added device listed after clicking save. If
the group already contained devices you will see an updated list of all devices in that
group.
To remove a device from an existing group

1. Click Printers from the main menu and Printer Groups, Maps from the drop-down
menu to view a list of groups already created

2. Click Edit in the Edit Column
3. Select the devices from the list of grouped devices displayed on the Edit Printer

Group screen and click Exclude. The devices will be deleted from the selected group.
You can also add the selected devices to another group by selecting the devices and a
different group name and click Add to Group.
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Adding Maps and Floor Plans to a Group
Groups can also have images of maps, floor plans, etc. assigned to them, which in turn
allows PSV to display the location of a device icon on an associated map or floor plan.
Several popular image file formats for maps and floor plans are supported, such
as .gif, .jpg, .bmp, or .png.
You can assign a map or floor plan image to a new group as soon as you create the group
or you can add a map / floor plan image to an existing group at any time.
To add the image while creating the group:

1. Select Printers from the main menu and click Printer Groups, Maps.

2. Select a saved image file from the drop down menu and click Save or click Upload

New Map to browse for your desired image. Once an image has been located, click
Upload.

3. Place a device icon on the map or floor plan
Note: Remember the individual device must be a member of a group before it can be
placed on the map.

4. From the main menu select Printers and Printer Groups from the drop down box. If
you have successfully linked an image with a group, you will see an icon in the map
column.

5. Click the map icon and the image will be displayed.
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6. Click Place on Map, and select a device from the drop down menu.
7. Click on the image and the device icon will be placed where your mouse pointer is
positioned

To move the device icons at any time, click the Place on Map button and drag and drop
the icon to the desired location on the map. Left click once more to activate.
Remember, when viewing the map or floor plan, the interactive icons can be clicked at
any time to go directly to the device’s status page (displayed below).
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While on the Device Status Page, you can link back to the map or floor plan by clicking
the On Map button.
Note: If you return to the map or floor plan from the Device Status Page by clicking
the On Map button you will only see that device’s icon displayed on the image. To see all
devices on the map or floor plan, click Printers from the main menu and select Printer
Groups, Maps from the drop down box. Click the map icon associated with a particular
group.
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Discovering Devices
To discover devices on your network, click Printers from the main menu and select
Discovery from the drop down menu. PSV is capable of discovering any device that is
compliant with Public MIB Specification RFC 3805.

Click Start Discovery if you want to discover all of the compatible devices on your
network. For large organizations, see Importing IP Addresses from a Text File:
Making Discovery Easier: section before starting the discovery process.
For Enterprises with several hundred or even several thousand devices, it may be time
consuming to discover all devices at once.
PSV provides the flexibility to selectively discover individual subnets or ranges of IP
Addresses by simply selecting the appropriate check box and clicking Start Discovery.
Discovery: Add Button
Click the Add button to selectively discover devices.
The Add button allows you to:
 Add an IP address of a device to the discovery database
 Create a discovery list based on IP subnet entered
 Create a discovery list based on a range of IP addresses indicated
Click the IP Address radio button and click Next.
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When adding a specific IP address to the discovery database, PSV provides an option to
assign the device to a specific group of devices and associate the group to a specific SNMP
community.
Enter an IP address, select a group name from the Printer Group drop down menu and
type the desired SNMP community. Click Add to save your changes.

Similar to adding a single IP Address to a database, click the IP Subnet or IP Range
radio buttons to create a discovery list for a specific IP Subnet or Range of IP addresses.
PSV also provides the option to assign a group name to the subnet or the IP address
range by selecting a predefined name from the group drop down menu or by clicking on
the map/group button if you would like to create a new group name.
Enter the appropriate information and click Save.
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Discovery: Exclude Button
Use the Exclude button to exclude a specific IP address or IP address range from the
discovery process.

1. Click the Exclude button and select either Exclude IP address or Exclude IP range
and Click Next

Notice that PSV displays all IP Addresses and IP Address Ranges that have been excluded
previously.

2. Enter desired IP address to exclude and click Save, or for IP Range, enter the range
of IP addresses to exclude and click Save.
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3. To include an IP address that was previously excluded, return to the Discovery section,
click the Exclude button, Click on one of the IP addresses listed as previously
excluded and click the Delete button.

Discovery: Windows Button
From the Discovery screen, click the Windows button.
The Windows button provides a list of devices that have been saved in the local system’s
Windows Print Queue. The local system is defined as the desktop or server that PSV is
running on. Each device listed can be selectively saved to the discovery database.

1. Click the check boxes to select the devices to add to the discovery database
2. Click the Start Discovery button.
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Discovery: Schedule Button
Discoveries can be scheduled to occur on a regular basis by clicking the Schedule button.

Click the Add Discovery Schedule button
Indicate the appropriate date, time and a recurring interval that you desire for the
discovery to take place. PSV can also send you an email each time discovery takes place.
Enter the appropriate email address if desired. Click Save to save the discovery schedule.
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Discovery: Logs Button
PSV records a log of all discoveries performed (and several other system activities) and
indicates whether the discovery was successful or not.

Click the Logs button to view the system activity log.
To obtain just a Discovery log, select Discovery from the Type drop down box, indicate
time frame by entering desired dates and click Show to display the log.
Note: This feature creates activity logs for all other activities supported in the drop down
box.
Caution: Clicking Clear Log will delete all discovery log entries permanently.
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Discovery: Show Addresses check box
Selecting Show Addresses displays a list of all IP addresses that PSV attempts to
discover when a Discovery is performed.

Discovery: Start Discovery Button
Clicking the Start Discovery button begins the discovery process for all subnets and IP
address ranges selected.
After the discovery process is complete, clicking the Printers button at the bottom of the
screen will display a list of the devices that were previously discovered with refreshed
status.
Clicking the Discovery button takes you back to the main discovery screen.
Clicking the Collect Data Now button collects more printing device data from and saves
in PSV database.
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Discovery: Settings Button
By clicking the Settings button you are linked to a universal page that is not specific to
just Discovery options.

Settings specific to Discovery are circled in the screen shot below:
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Configuring Timeouts
The SNMP Get timeout value controls the length of time PSV will wait for a response from
the device before timing out. Keep in mind the greater the SNMP Get timeout value, the
longer the overall discovery will take.

SNMP Discovery Delay
The SNMP Discovery Delay value can also be configured. This value sets the delay
between each discovery request. This value may have to be tuned to suit the network
configuration considering the number of devices being discovered.

Status Icon Timeout
The status icon timeout value sets the time interval that PSV waits for a response from a
device before turning the status icon gray (status icon is displayed in the Printers List).
Notice that after clicking Refresh, the status icons are returned to an active state. Enter
a desired value for each option and click Save.

Retry Interval / Retry Maximum Wait
The Retry Interval / Retry Maximum Wait values can be configured, and may have to be
tuned to suit the network configuration.

Use DNS Addresses
Use DNS Addresses translates IP addresses to DNS names if possible, and saves them in
the PSV database. When a list of devices is displayed in other areas of PSV, you will see
the DNS address name displayed instead of the IP address. This is particularly helpful
when an organization uses DHCP.
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Importing IP Addresses from a text file: Making Discovery Easier
As an alternative to running discovery, you may also import a list of devices using a CSV
file.
In some organizations, IT departments may keep track of the IP addresses of their print
and copy devices in a text file. If such a file exists, you can use PSV’s “Import” feature to
speed the discovery process. This is done by simply importing the text file:
1. From the main menu click Printers and select Import Printers & Attributes

2. Click Browse to locate the desired file. The text file should be formatted so that one
device address is on each line of the file. For more detailed instructions click the
Instructions button.
3. Select an appropriate group name from the Printer Group dropdown box (or leave
blank).
4. Select the way the file is delimited by selecting comma, semi colon or tab
5. Select the format of the text file: UTF-8 is the normal format. Select the format out of
the list shown in the drop down list.
6. To add only new devices added to the CSV file since the last discovery, select Skip
addresses that are already in the database checkbox.
You may click Preview to view the data before importing it or Click Import to add the
devices immediately. The import process can also be automated and scheduled to occur
on a regular basis.
To schedule an import:
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1.
2.
3.
4.
5.
6.

Click the Scheduled Import button
Enter the location of the file to be imported in the Import File Path field
Enter a printer group if you want the imported devices to be placed in a specific group
Select the way the file is delimited by selecting comma, semi colon or tab
Select the text file format
To add only the new devices added, check Skip addresses that are already in the
database checkbox
7. Click Save
8. Click the Import Schedule link to indicate when the file should be imported

9. Click the Add Import Schedule button

10.Enter date, time, recurring interval and who should receive the confirming email, click
Save
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Discovering Network Devices: Easy Configuration
If you have installed the single-user “Easy Configuration” option from PSV Professional
Edition you will notice there are fewer discovery options.
Click Printers from the main menu and select Discovery from the drop down box. The
two options available are: Add Subnet and Exclude. Both features are included in PSV
Enterprise. See previous discussion for a complete description of these features.

My Printers
An alternative way to group devices together is to use the My Printers feature. It’s an
easy way to view device status with minimal mouse clicks.

1. From the main menu select Printers and My Printers from the drop down box. You
will see a list of devices that have been added to the My Printers group.

2. To add a device to the My Printers group, simply click the Add Printer button, choose
the desired device and click Save.

3. To delete a device, click the trash can icon / Delete button listed in the right column.
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Near Me
Another time saving, grouping feature available in PrintSuperVision is called Near Me.
From the main menu select Printers and Near Me from the drop down menu. Device
status in the Near Me group will be displayed

Near Me allows a user to quickly view the status of devices that are conceptually located
near the PC being used, without the need to configure or group devices.
PSV detects and locates devices that have similar network addresses to the client
computer (or browser enabled device) being used to access the PSV application and
automatically includes those devices in the Near Me group.
Note: Devices cannot be added or deleted from the Near Me group.
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Computers with Agents
If you have installed the PSV Agent on desktops or laptops within your organization to
monitor USB-connected Oki print devices, you have the ability to search for and view
those client computers from PSV.
Click Printers from the main menu and Computers with Agents from the drop down
menu.

You can search for the computers on your network that are running the PSV agent by
using Site, Search, and whether the Agent is Active or not. Click Show to perform the
search.
When the search results are returned, you can view all of the print queues and print
drivers that an individual user has installed on their computer and can even obtain
consumable status and printed page counts from Oki print devices that are connected via
USB.
To view individual print queues, click the Printer Queues link.

48

To view the status page that contains page counts, supplies status and the current
operational status for a device, Click the Printer link.
To view Windows Job Logs return to the Computers with Agents screen and click the
Windows Job Logs link. This will display a list of jobs printed and provides many filtering
options.

Status of Print Devices
For a quick view of current status of all devices being monitored, click Printers from the
main menu and select Status of Print Devices from the drop down menu.
Select a status category from the list on the left. Devices matching that status will be
displayed on the right.
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To obtain more detailed status of an individual device, select the word “Log”. Historic
data collected by PSV will be displayed for that device.

PSV normally uses SNMP to communicate with Print Devices, but from time to time you
may want to know if a device is responding by doing a simple Ping. The Ping feature is
available from the Status of Print Devices screen.
Click the word Ping in the list of devices or Click the PingDB button or PingCSV button
which will indicate whether the device is responding or not.
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The Ping DB button only pings device addresses that are saved in the PSV database,
while Ping CSV will only ping the devices saved in the CSV file used to import your
devices.

The SNMP DB button provides status of all devices saved in the PSV database by using
SNMP while the SNMP CSV button provides status of only those devices listed in the CSV
file used for device import.
The Optimize button for both Ping and SNMP queries, only targets the devices that did
not respond to the earlier request, thus streamlining the process.
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Configuring Email Alerts
PSV can notify a helpdesk or network admin that a device has generated an alert.
Alert notifications are available in the Enterprise Edition and the server configuration of
the Professional Edition. Alerts are not available in the single-user Easy Configuration
option in the Professional Edition.
Note: Only users with Admin rights can edit email alert configurations or set alerts for
other users or user groups. A non-Admin user however, may configure and view Alerts
just for themselves.
PSV uses email to deliver alert conditions. The email message can be sent to an
individual user or a group of users.
An Alert can also be saved in a “log file” or processed by another software application (if
you choose to perform the integration).
Each alert can be configured to be processed immediately upon receiving updated status
from the device, or processed at specified time intervals.
To add an email Alert:

1. Select Services from the main menu and Alerts from the drop down box

2. Click the Add Alert button.
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Adding an alert requires the following information and steps

3. Identify the device or a group of devices to monitor and select it from the Printer:
drop down box

4. Select how often you would like the Alert to be sent from the interval drop down box
5. Next, you have the option to select Usage or Status from the “Based On” drop down
menu. Some explanation may be required before proceeding:

A Status based alert instructs PSV to act upon events that are generated directly by the
print device and generally describe a device state such as “cover open” or “paper out”.
A Usage based alert is used for monitoring supplies and maintenance items such as toner,
drums, transfer belts and fusers. A greater level of detail can be applied to Usage based
Alerts since you can set life remaining thresholds for each item.

Usage-based Alerts
6. Select Usage from the drop down menu

Notice in the screenshot above that you have the ability to choose all supply and
maintenance items or just the items that are most important to you.
You also have the ability to set the life remaining threshold that triggers the alert. So in
the example above PSV will send an alert email whenever toner or drum exceeds 20% life
remaining.
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In order to assign different life remaining threshold values to each individual supply or
maintenance item you must create separate Alerts for each item.
7. Select the supply items that you wish to create an Alert for
8. Enter a % life remaining threshold in the Value field that applies to each supply item
checked
9. Select the appropriate action from the drop down menu that will occur when an Alert
condition is met. Select Send Email to have the Alert message delivered by email.
Note that there are 2 additional options in the drop down box: Run Program and Log
Alert Only. Both will be discussed later.
10.Select the user or group of users the Alert message will be sent to
11.Select the format of the email message (text or html) to be sent. To avoid duplicate
alerts, select the Email format option: Individual Email for each Event.
Note that while this option may reduce duplicate alerts, the number of email alerts will
multiply since one alert will be sent for each device and each condition.

10. Click Save after the information has been entered
Status-based Alerts:
To select a Status based Alert, return to step 5 above by clicking the Back button or by
clicking the Add Alerts button from the main Alerts screen.

1. Select the Event group that will trigger the Alert. For example, select “Error” if you

only want to be notified when the device reports an error condition. Individual status
conditions have been grouped in this list for convenience.

Keep in mind that if you have previously added events manually they will automatically be
displayed in this drop down box

2. Select the appropriate action from the drop down menu that will occur when an Alert
condition is met. Select Send Email to have the Alert message delivered by email.

Note: As mentioned previously, there are 2 additional options in the Event drop down
box: Run Program and Log Alert Only.
Run Program allows PSV to call another windows based application that can be installed
on the same PSV server. Using Run Program requires custom integration not included in
PSV.
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Run Program Action, available in Enterprise Edition only, requires providing full file-path
(on the computer where PSV server is running) or the program to be called when the Alert
match is found.
The program is called by the PSV server with a standard set of arguments.
For example: .BAT file:
1:date 2:time 3:address 4:model 5:supplies_type 6:supplies_level 7:supplies_sku

Log Alert Only adds the Alert into a running log file.

3. Select the user or group of users the Alert message will be sent to
4. Select the format of the email message (text or html) to be sent. To avoid duplicate
alerts further, select the Email format option: Individual Email for each Event.
5. Click Save after the information has been entered.

Note: For some OKI models, such as the B6500 and some B700 series models,
configuring Status Alerts requires the creation of custom events. Usage Alerts are not
affected and can be configured as described previously.
To create a custom event and corresponding Status Alert, Click the Add link located next
to the Event drop down menu. You will be directed to the Add Alert page.

Create a name for the event and type it in the Name field. Select the severity of the
event and describe the status of the event as it appears on the operator panel of the
device. Click the Add Event button.
See the Configuring Status Events section on page xx for more detail
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Configuring an Email Server for Alerts:
1. To set the parameters for sending alerts in email, click the Configure Email button

from the Alerts page. If you already configured email settings using PSV Setup utility,
those settings will be displayed.

2. Enter the following information and click Save:










The
The
The
The
The
The
TLS
The
The

address of your email server
Administrator’s email address
Sender’s name that will be placed in the “From” field in the email
email method
Username and Password for authentication if required
SMTP Port
or SSL Encryption
Subject of email message
maximum number of message attempts

Note: To test whether the email configuration is correct, click the Send Test Email to
Admin button. PSV will attempt to send an email to the address specified.

3. To select the Print device properties to be included in the email alert message, click
the Email Properties Button.
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4. Highlight the desired properties to be included in the email alert message and click
the Add button. It will appear in the Selected Properties column. To remove it,
simply highlight it and click the Remove button.

For convenience, four pre-populated lists of properties are available by clicking the Load
From button. The choices are: Standard, Long List, Toners and Toner Details.
Once selected, you will notice that the properties associated with a pre-populated list are
already entered into the “Selected Properties” column. Don’t forget to click Save to save
your settings.
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Testing The Email Alert Configuration:
For convenience, you can click the Process Alerts Now button to make sure everything
is configured properly. PSV will process the alert and send an email message to the
assigned recipient.
Note: the “Process Alerts Now” function is system wide and not tied to a particular device
or group. Therefore, if you have a large number of devices in your network, it may take
an extended period of time to scan your entire fleet of devices and send the alert email.

Configuring Status Events:
PrintSuperVision allows you to customize certain events that trigger notification emails.
An “Event” is different than a standard Alert condition where the print device generates
the Alert and PSV delivers the Alert in an email.
A customized Event can be created where a single condition or several conditions are
assigned to one Event. This can be useful if you only want to be notified when a critical
condition is met or when several conditions are met.

1. To add or modify an event, go back to the Alerts page and click the Status Events
button.

A list of default events is displayed. You can add an event by clicking the Add Event
button, or review the conditions of each existing event.
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2. Click the name of the Event to see a list of conditions that are assigned to that event
category. Click “Toner Low” for example

This Event is configured to send an email alert when toner is less than or equal to 15%
remaining.
Notice also that PrintSuperVision translates difficult to understand proprietary error codes
displayed by the device into meaningful descriptions.
Click your browsers back button

3. Click the Add Event button

4. Enter a unique name for the customized event
5. Assign a severity level to the event by selecting one of the options from the drop
down box

Note: It is not necessary to fill in the Status Messages field. Entering a description in
that field instructs PSV to try and match a similar description of a message that is
displayed on the device’s Control Panel. This is an alternative method to adding Alerts by
entering a name and severity level described above.
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Keep in mind that the description displayed on the device operator panel must match the
description you entered in the Status Messages field exactly in order for PSV to
recognize the condition and act upon it.

6. Select one or more conditions to assign to the event by selecting the check boxes in
the left margin.

7. Click the Add Event button to save the customized Event.

Customizing Status Codes:
PSV also allows you to customize the severity level of any of the status code conditions.
By default, PSV has assigned a predefined severity level to each status code, but you may
decide that a code is too critical or not critical enough for the default code so you have the
option to change the status code displayed in PSV.
To modify status codes:
1. Return to the Alerts main page and click the Status Codes button.

2. Scroll through the list of conditions or type in a search word to narrow your choices.

3. Click on the severity level icon listed in the Edit Severity column.
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4. Select the new severity level from the drop down menu and click Save

The default severity level and the new severity level will both be displayed in the Status
Codes page. You may go back and change the severity level at any time.

Processing Alerts /Generating Alert Logs:
This section discusses the functionality of the Users button, the Process Alerts Now
button and the Alerts Action Log button.
Click your browsers back button to return to the Alerts main page.

The Users button is provided for navigation convenience and links to the All Users page.
The Process Alerts Now button processes all outstanding Alert conditions immediately.
As mentioned previously, it is a system wide command and will scan every device in the
network and process outstanding Alerts. If you are monitoring several thousand devices
on the network, this process may take an extended period of time to complete.
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The Alert Action Log button takes you to the following screen where you can selectively
generate a list of all Alerts that have been processed for a single device or group of
devices.

This page provides a history of the alert logs that were sent by PSV. The alert logs can
be filtered by alert ID, date range, and alert status (active, cleared, deleted).
The Update Time option indicates the amount of time an Alert has been in an Active
state (it is calculated by subtracting detected time from updated time).
The Update Time format is displayed in days followed by hours. This feature is
particularly helpful in determining response times by viewing the amount of time the Alert
was in an Active state, or in other words, the time it took to clear the Alert.
The Working Hours option displays the amount of time (adjusted for work hours) that an
Alert has been in an active state, and can also be used to estimate response times.
To change the status of an Alert Log from Active or Cleared to Deleted, click the checkbox
in the Delete column of the appropriate row(s). Once selected, click the Delete Selected
button to make the change.
Any rows that have their status changed to Deleted will still be shown on the current page
even if the Deleted checkbox is unchecked. This will continue until a different set of Alert
Log entries is selected or the user moves to a different page in the results.
If you need to change the status of a specific Alert Log or a large number of entries at the
same time, from Active or Cleared to Deleted, the following suggestions could make this
task easier:
a. If you have a large number of entries, use the Alert ID drop-down list to search
for and work on a single alert
b. Use the From and To dates. For example, you may want to look only at entries
that have not been updated in over one year.
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c. Uncheck the Deleted checkbox. If you are not interested in Cleared items, then
uncheck the Cleared checkbox as well
d. Select ‘All Alerts’ from the ‘Number of alerts per page’ drop-down list. All of the
Alert Log entries that match the specified conditions will be shown on a single
page.
e. Use the ‘Select All’ button to select all of the entries shown on the current page.
Individual rows can be unselected by clicking the Delete check box of that row.
f. Click the ‘Delete Selected’ button. All of the records with a check in the Delete
column will have their status changed to Deleted.

Processing Alerts: Setting the Data Collection Interval
PSV periodically collects data from print devices and saves it into a database, thereby
enabling PSV to create reports or generate Alerts. Users with Admin rights can configure
the data collection interval time in hours for basic usage information and in minutes for
processing Alerts.
To set the data collection interval:
1. Click Services from the main menu and select Data Collection Services from the
drop down box.
2. Indicate the desired data collection interval times and click Save.

To display a log of previous data collection activity for a selected date range, enter the
appropriate date and click Show. PSV will list all data collection activity from the date
indicated to the present date.
For added convenience, click the Collect Data Now button and specify options. Click the
Start button to begin processing.
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Configuring Print Devices Remotely
In addition to monitoring and managing print devices, PSV Enterprise includes tools for
automating the configuration of print devices in the field. This is helpful when you are
configuring a large fleet of multi-function devices that may require several configuration
settings such as populating Email Address Books or Fax Phone Books on each device.
The configuration tool makes it possible to configure all compatible devices with the same
parameters, as well as the ability to configure individual devices with desired values.
The configuration values can be saved in the PSV database and later used to re-configure
(i.e. clone) all devices to desired default values with one mouse click.
Examples of how the configuration tool can be used are:
 Common configuration values such as “system contact” can be imported into PSV
and then applied to multiple devices.
 Email and fax address books used in MFP devices can be imported and quickly
applied to multiple MFPs. PSV allows an address book to be configured with a
combination of shared addresses that are common to all devices and local
addresses that apply only to a single device.
 Scan profiles for MB4xx MFP devices can be imported and quickly applied to
multiple MFPs. PSV allows the scan profile to be configured with a combination of
shared values that are common to all devices and local values that apply only to a
single device.
 Once a device is fully configured, that configuration can be saved and used to
configure similar devices as they are brought online or to restore a device to a
previous configuration.

Configuration: Behind the Scenes:
PSV uses HTTP (web) protocol to do most of the configuration of print devices. This means
the PSV program helps automate what can also be done manually from a print device’s
embedded web page. With large networks, this automation can save a tremendous
amount of time and ensure all devices are configured consistently and quickly.
The Configuration tool in PSV can be used in three ways:



Configuration settings can be applied selectively to one device at a time
Configuration parameters for individual devices can be saved as attributes which
can be used to configure one or more devices.
 Configuration parameters that are the same for all devices can be saved as
common attributes. Once saved to the PSV database, any compatible device can
be configured with these values. “Common” attributes have preference over
individual attributes.
To help populate the PSV database with attributes, there is an “Export/Import” feature
that can import both individual and common attributes from a CSV file. Attribute values
can also be exported to a CSV file. This can be used to obtain the required attribute
names that need to be in the first line of CSV files.
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Configuration settings can be made on a device by device basis or by cloning a selected
configuration and sending it to a fleet of devices at one time.
Note: There are two areas within PSV where remote device configurations can be made:
Tools / Configure Print Devices and Tools / Configure MFP Devices. Even though the OKI
MB460/70/80 are MFPs, you must use the Configure Print Device area to configure those
MFP models. For all others, remote configuration is performed from the Configure MFP
Device page.

Configuring Individual devices:
PSV uses the devices’ embedded web page to change configuration values, therefore,
when settings are made using this module, it is the same end result as making a
configuration change from the device’s embedded web page.
Select Tools from the main menu and Configure Print Devices

Note: The “Configure Print Devices” page is available only to Admins
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Configuration Requirement: Device Web Password
Since PSV uses the print devices embedded web page to make configuration changes, it
requires the embedded web page password in order to make those changes.
PSV uses the factory-default password unless an alternative value is entered when using
the Edit feature. Click the Edit button next to the Print Device drop down menu.

In the Web Password field, enter the password that your organization uses for each
device’s embedded web page.
Note: This setting is only needed if the web passwords have been changed from factory
default. For most devices, the factory default password is “aaaaaa” or the last six digits of
the device’s MAC address.
You can click the verify button to see if the web password was correct. Don’t forget to
click the Save button after verification.
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Obtaining Current Configuration Values from each Device:
Before making configuration changes on an individual device you may wish to view
current configuration settings for that device.

Select the print device model you wish to make configuration changes on.
The Device Model drop down displays a list of models that are compatible with the
automated configuration feature. Only print devices in the PSV database matching the
selected models in the drop down menu are able to have their configuration settings
retrieved. “All Models” can be selected to read all compatible devices. Click the Select
button after choosing a new model from the list.
The Print Device list shows the individual devices in the PSV database that match the
Device Model selection. You can use this to restrict configuration to a particular printer.
The All compatible selection in the print device drop down menu extends the selection to
all printers that match the selected model type.
Config Form is a group of configuration values that are similar in purpose. The Config
Form selection controls which configuration values are retrieved from the device.
Select All Forms from the drop down menu to retrieve all available configuration values
from the device. Click the Get Values from Devices button after you have made your
selections for Device Model, Print Device, and Config Form. PSV will then connect to the
appropriate devices and obtain the form values indicated.
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From the list of configuration settings you can make changes to the current values by
selecting a new value from a drop down menus.

Click the Set to Device button to send and save all configuration changes to the device.
Note: When certain networking options are changed, the device may auto restart. This is
necessary for the changes to become active. A device restart will normally complete in
about 30 seconds.
If the print devices are configured for “dynamic” network address (DHCP), and network
servers do not reserve IP addresses, the IP address of the print device could change after
the device restarts, and effectively it could become unreachable from PSV until the new
address is found using the Discovery feature. Most of the time this is not an issue since
DHCP servers typically re-assign the same IP address to a device.
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Configuring Several Devices at Once:
As mentioned previously, configuration data from each print device can be saved in PSV’s
database to be reused later for multi-device configuration and set up. The saved
configuration settings are called attributes and each has a unique pre-defined name
recognized by PSV, i.e. “SNMPv3_Username”.
Distinct attribute values can be saved for each compatible printer. Attributes can also be
saved and shared by all compatible devices. Attributes shared in this way are called
common attributes.
The steps to configure several devices at one time are summarized below:
1. Check the Show Attributes & Common box
2. Click the Get Values from Devices button
3. Edit the Current Value fields and select the desired attributes to save into the PSV
database by checking boxes
4. Click the Save as Attribute or Save as Common buttons

Saving Attributes to the PSV Database:
To save Attributes to the PSV database, enter the desired value in the Current Value
fields or select the desired value from a drop down list.

Select the values to be saved by clicking the desired check boxes in the Attribute Name
column. Click the Save as Attributes button.
Note: Clicking the Save as Common button saves the data as a common attribute shared
by all devices.
Any attribute values or common attribute values that have been saved are shown in the
“Attribute Value” column. A “*” next to the attribute name indicates it is a common
attribute.
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To delete a value from the PSV database, click on the “X” next to the value in the
Attribute Value column.
Note that common attributes have preference over individual attributes. If both common
and individual attributes are defined in the database, the common attribute will be
displayed and used.
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Set Values from Attributes
When the print device’s configured value is different from the saved attribute or common
attribute value, the database attribute value is shown in red.
When a print device’s configured value is the same as the saved value in the PSV
database, the value is shown in green.

Click the Set Devices from Attributes button to apply the attribute values in the PSV
database to the selected device. The changes are applied to all devices selected in the
“Print Device” list. By selecting “All Compatible”, PSV will apply all attributes from the
database to all devices that support the selected form.
If “All Forms” is selected for Config Form, the program will apply changes to all forms that
match. If “All” is selected for both Print Device and Config Form, the program will make
sure that all devices are in-sync with desired values stored in the PSV database when Set
Devices from Attributes is clicked.
To avoid unnecessary delays, PSV first tests if the print device(s) are on the network by
using SNMP protocol and provides a list with checkboxes next to addresses of matching
devices. Those who respond to SNMP v1 have the checkbox checked.
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Click the Set Selected Devices from Attributes button and PSV will apply changes only
to the devices that have the checkbox checked next to the IP address.
To verify that the new values have been configured in the device, click the Get Values
from Devices button. The attribute values should be listed in green.
Note that “Common” attributes will be visible with all devices, not just with the device
selected when saved to the database.

SNMP Test Connection Checkbox:
The “Configure Print Devices” feature uses SNMP v1 to determine if the device is available
on the selected network and verifies that it is the same device in the PSV database.
If the print device is configured to respond only to SNMP v3, uncheck the SNMP test
connection checkbox, to make sure PSV is able to communicate with the print device.
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Exporting / Importing Configuration Data:
Populating the PSV database with attributes can also be accomplished by clicking the
Export / Import Config Data link. It may be easier to first “Export Attributes” to
create a template file containing the names of the attributes. Such a file can be edited in
Excel or a similar tool, and then “imported” back into PSV.

Select Export Attributes from the drop down. Click Select. Choose the appropriate
Config form and Click Export. Click the Export CSV button.
Note: The first line of the CSV file is comprised of the PSV attributes contained in the file.
The first column must be the address of the print devices (IP or DNS). Import Attributes
supports a number of encoding formats.
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To import a CSV file that contains a list of devices and their attributes select Import
Attributes from the drop down and click Select.
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Sample Configuration Exercise:
In this example the goal is to set all network protocols that are not used to disabled, and
to set SNMP v3 enabled along with SNMP v1 and v2.
The first step is to select a print device. The attributes we are interested in are part of the
“Network -> Basic Setup” form.
Select this form from the “Config Form” list. Make sure the “Show Attributes and Common”
checkbox is checked then click “Get Values from Devices”.
Next, modify the values that we want to be the same for all devices. For example, set
“Netware” to Disable. Check the checkbox next to it (“B7x0_Netware”) and click the Save
as Common button.
Finally, click Set Devices from Attributes to apply the changes to the selected device.
Common attributes apply to all compatible devices, so by selecting “All compatible” for
“Print Device” and clicking Set Devices from Attributes the selected common values will
be applied to all compatible devices found in the database. This feature can be used to
reset device settings to desired values that have been saved to database.
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Configuring Email Address Book and Fax Phone Book
For MFP devices that support scan-to-email and fax transmission, you can remotely
configure the device to add or change email addresses and fax phone numbers. The
configuration process to add or change email addresses or fax phone numbers is similar to
the way other device properties are remotely configured.
Caution: When adding or editing email addresses and fax numbers to a device the
values must be entered in a specific format, i.e. a specific syntax must be followed (see
screen shot below). The syntax may differ between models so check with an OKI
technical resource before attempting to add or edit these values.
Note: If the values are not entered correctly, the device will not accept the configuration
changes. The top line of data is designated as the header followed by individual email
addresses. In this case, the values are comma delimited.

Step 1: Set new values directly to the device through the embedded web page
Step 2: Read the current values from the device clicking the Get Values from Device
button
Step 3: Save the attributes as regular attributes or common attributes by clicking the
appropriate button
Step 4: Save the attributes to each device by clicking set the device
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Exporting / Importing Email Address Book and Fax Phone Book values
Like other forms, the values in the email address book form and fax phone book form can
be exported to and imported from CSV files. However, there is one important difference
specific to Email Address Books and Fax Phone Books: their forms can have records that
are “shared” (common) among multiple devices.
For example, there may be situations where a common set of fax phone numbers need to
be configured in every MFP device, and in addition, some devices require unique numbers
aside from the common set of numbers. This is achieved by “merging” records that have
a “*” in the address column to all devices in the CSV file. Such a merged list is saved to
PSV’s database to be applied to individual devices.
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Configuring Scan Profiles:
Many OKI MFPs have the ability to use “scan profiles” which instruct the device to send
scanned documents to shared folders, FTP and HTTP resources.
Scan Profiles can be created and configured from the device’s embedded web page one
device at a time or by using PSV to configure many devices at one time.
Configuring Scan profiles are performed in much the same way in PSV as configuring
other device properties.
There are 2 different methods available to configure Scan Profiles using PSV:
1) The “Common Attributes Template” method
A simple configuration starts by configuring a target MFP device with the desired
configuration through its embedded web page. PSV can then be used to obtain the
configuration from the target device by reading it and saving it to the PSV database.
The configuration template can then be modified as needed and applied to another MFP
device, a group of devices, or all compatible devices.
This method is practical when all devices need to have the same set of profiles and only
requires optional destination folders for each device or a different destination share server
address.
2) “Exporting / Importing Scan Profiles” from CSV
In some cases, MFP devices need to share the same scan profiles but also need unique
profiles specific to each individual device. In such cases PSV can “Export” Scan Profiles
from one or multiple MFP devices, allow the user to edit the profile in another
application such as Excel, import it back into the PSV database and apply to all
compatible MFP devices.
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Method 1: The “Common Attributes Template” method
The first step to method 1 is to configure a Scan Profile on a target device by accessing
and using the devices embedded web page. Login to the device web page with username:
root and default password: aaaaaa.
Select Scanner Menu, click Scan to Network PC, click Profile Manager, click New or
Modify (New to create a new profile, Modify to edit an existing one).

Make appropriate changes to the profile setting page (displayed on the right side of the
split screen above) and click Submit.
It’s useful to try using a scan profile after creating or editing it to make sure it works as
expected before applying the same or similar configuration to many other MFP devices
using PSV.
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Getting and Setting a Scan Profile to one MFP device:
The second step is to acquire the scan profile configuration values from the target
machine using PSV. In this example the scan profile values will be applied to one device.
The next section will describe applying the values to many devices.
Return to the Configure Print Devices page: Click Tools, click Configure Print
Devices, and select an MFP model type from the device model drop down.
Select an individual device from the Print Device drop down. From the Config Form
drop down, select the Scan-> Scan Profiles form. Click the Get Values from Devices
button.

If any changes to the profile are required, make them now. After making changes, click
the Set to Device button to send the configuration values to the device selected.
Note: The first row of text includes names of fields. Each profile starts with number: #nn
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Configuring Scan profiles to several devices:
Before describing how to apply a scan profile to many devices, a short discussion on
common attributes is needed.
Common Attributes for MFP Scan Profiles
When multiple devices are sending scan files to the same (FTP or CIFS) share server, it is
usually required to have those files saved in separate folders: first to make sure files with
potentially same names do not override other files and second to be able to know which
MFP devices have sent the file to the server.
A very simple method to achieve this “unique folder for each MFP device” is to:




Get current Scan Profiles from an already configured MFP device
Modify the profiles to add template {Markers} in the CSV text and save it as a
Common Attribute
Then select a group of devices or all compatible devices and click Set Devices
from Attributes.

Return to the Configure Print Devices page by clicking Tools / Configure Print Devices.
Obtain the Scan Profile values from the target MFP device that you previously configured
using its embedded web page.
Select an MFP model type from the device model drop down. Select an individual device
from the Print Device drop down. From the Config Form drop down, select the Scan->
Scan Profiles form. Check the Show Attributes and Common checkbox and click the
Get Values from Devices button.
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The original Scan Profile values will look like this (trimmed for clarity):
EntryNumber,Name,Protocol,TargetURL,PortNumber,…
#01,HR_01,FTP,//172.31.44.195/scan/HT_01/172.31.19.95,21…
#02,IT_02,FTP,//172.31.44.195/scan/IT_02/172.31.19.95,21,…
#07,SALES_07,FTP,//172.31.44.195/scan/Sales_07/172.31.19.95,21,…
Please observe “TargetURL” field starts with address of server (172.31.44.195), and the
destination folder includes address of MFP device (172.31.19.95). The goal is to make this
URL unique for each device, so we modify the CSV text to:
EntryNumber,Name,Protocol,TargetURL,PortNumber,…
#01,HR_01,FTP,//172.31.44.195/scan/HT_01/{ADDRESS},21…
#02,IT_02,FTP,//172.31.44.195/scan/IT_02/{ADDRESS},21,…
#07,SALES_07,FTP,//172.31.44.195/scan/Sales_07/{ADDRESS},21,…
Make sure the Scan Profiles checkbox is checked and click the Save as Common button.
This will save data to PSV’s database as a generic template, where {ADDRESS} marker
will be replaced with the actual address of each MFP device.
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Select another device from the list, and click the Set Devices from Attributes button

This will obtain a “Common” template from the PSV database, replace {ADDRESS} marker
with actual address of selected MFP device (in this case ‘172.31.19.57’), and apply a new
value to the selected device.
Select “All Compatible” devices and apply, and they will all be configured.

Besides {ADDRESS}, the system supports {NAME} and {LOCATION} properties, and any
other attribute that can be assigned to print devices as described in previous sections of
this document.
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Editing Common Scan Profiles and Attributes
To modify a Common Scan Profile template, click on Edit Common link.

Expand text box next to “Scan_Profiles”, edit CSV text, and click Save.

Note: that “Common Attributes” can include any name-value pair. You can add at the
bottom of the form both new name and value and save. In this case we have added
“FTP_SERVER” attribute, with value “172.31.44.195”. Now, we can make our Common *
Scan profiles even better, replacing the address of server with {FTP_SERVER} marker in
the CSV text.
EntryNumber,Name,Protocol,TargetURL,PortNumber,…
#01,HR_01,FTP,//{FTP_SERVER}/scan/HT_01/{ADDRESS},21…
#02,IT_02,FTP,//{FTP_SERVER}/scan/IT_02/{ADDRESS},21,…
#07,SALES_07,FTP,//{FTP_SERVER}/scan/Sales_07/{ADDRESS},21,…
The first benefit is that we can now change the address of the FTP server in only one place.
The second is that we can have the FTP_SERVER individually assigned as an attribute for
each print device, and imported to the PSV database as described in previous sections of
this document.
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Exporting / Importing Scan Profiles from CSV:
The second method to configure scan profiles for a fleet of similar devices is by creating a
CSV file with the configuration parameters and importing it to CSV and applying the
changes to the devices.
In some cases there is a need to have different Scan Profiles for each devices, not only
different folder, server, or scan option. There could be some common scan profiles that
should be applied to all MFP devices, and then individual scan profiles for each MFP device
as desired. This can be done by using “Export / Import Data” tool, “Export Scan Profiles”
and “Import Scan Profiles” options.
This technique provides complete control, flexibility and efficiency, but it does require
some additional effort to prepare and manage CSV text files with Scan Profiles.
As in a previous example, the first step is to manually configure Scan Profiles on one or
more template MFP devices by using the embedded web app on those devices. Then
select
Tools => Export / Import Data
-> [Export MFP Scan Profile], [Select]
-> [Device Properties\], [Printer or Group\], [Export]
-> [Export CSV], and [Save]

The resulting CSV file can be edited by any text editor, or by Excel or similar tool.
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The rows that have a ‘*’ in the ‘Address’ column will apply to all devices that do not have
Scan Profiles with same ‘EntryNumber’ already defined.
Please observe that rows are trimmed for clarity:
Address,EntryNumber,Name,Protocol,TargetURL,PortNumber,…
*,#01,ftp_01,FTP,//{FTP_SERVER}/scan/01/{ADDRESS},21,…
*,#02,ftp_02,FTP,//{FTP_SERVER}/scan/02/{ADDRESS},21,…
172.31.19.57,#00,ScanToRonsW7PC,0,\\172.31.45.63\SWE_Shared,445,…
172.31.19.57,#01,ScanToJCDsW7PC,0,\\172.31.19.58\SWE_shared,445,…
172.31.19.57,#06,Ubuntu,CIFS,\\172.31.19.134\smbuser,445,…
172.31.19.95,#00,DraganScanMB460,CIFS,\\172.31.44.195\scan\MB460,21,…
172.31.19.95,#03,eng_ftp,FTP,//172.31.1.41/incoming,21,…
In this case Scan Profile #02 for device ‘172.31.19.57’ will be
*,#02,ftp_02,FTP,//172.31.44.195/scan/02/172.31.19.57,21,…

The profile #01 will be as defined for specific device, not from Common, as well as #00
and #06.
In this case Scan Profile #02 for device ‘172.31.19.95’ will be
*,#01,ftp_01,FTP,//172.31.44.195/scan/01/172.31.19.95,21,…
*,#02,ftp_02,FTP,//172.31.44.195/scan/02/172.31.19.95,21,…
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Data can now be imported from CSV text file to the PrintSuperVision database
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Now that the values are stored in the PSV database, you can use the “Configure Print
Devices” feature as previously described and use Set Devices from Attributes to save
to individual devices, to a group of devices or all compatible devices.
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Configuring MFP Devices
MFP devices, such as the OKI MC561 and MB491 provide many options when scanning
documents. One option is the use of “Scan Profiles”. For a user of MFP device, Scan
Profiles appear as list of names on LCD menu after pressing “Scan” button and selecting
“Network PC” menu option. After pressing “Start” button MFP scans a document with preconfigured options, and sends it to a (file) server on pre-configured location, and with preconfigured filename.

Since files can be sent to the same file server from multiple MFP devices, with multiple
“Scan Profiles”, it is important to be able to recognize the purpose and origin of the
scanned file by its filename.
In an Enterprise network there could be many MFP devices that need to be configured and
managed. This is where the PrintSuperVision “Configure MFP Devices” tool is useful, since
it provides an efficient way to configure Scan Profiles on a large number of compatible OKI
MFP devices by a “one button click”.
To make filenames from devices different, Scan Profiles in each device can be configured
to indicate location of the MFP device. PSV admin can configure a “Template” for Scan
Profiles that is the same for all managed MFP devices, and it gets adjusted for each device
based on data from the database. For example, a new employee may be required to sign
and send an “HR-Form1”. Resulting filename can be “HR-Form1_Store123_052912133702.pdf”, where “HR-Form1” is for profile, “Store-123” is for location
of MFP, and date-time makes filename unique: 052912 is May 29, 2012, 133702 is
1:37:02 PM.
How to use the PSV tool to automate the process is described in this section.

Scan Profiles:
Scan Profiles are a collection of settings that the device uses when one or more
documents are scanned. The settings define things such as the resolution and format of
the scanned image and the location where the scanned file will be copied to. A user can
then select a Scan Profile from the device’s control panel, and the settings defined for that
profile are used when scanning. A user can enter the desired scan options each time he
or she uses the scan function, but this would be a slow process. It is better to configure
the device with Scan Profiles and let the user select from the available choices.
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PSV’s Enterprise Edition provides a tool for configuring Scan Profiles.
This tool is most useful when profiles need to be established on a large number of MFP
devices connected to a network. PSV can be used to “push” Scan Profiles to a large
number of devices.
The system can have a ‘Scan Template’ that can be applied to all compatible devices with
a single button click.
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Scan Profiles are configurations in MFP devices used for scanning and sending to
server.
Attributes are descriptions of print and MFP devices in the PSV database
Scan Templates are shared descriptions of scan profiles saved in the PSV
database. Scan Templates can include Attributes.

Using PSV to Configure MFP Devices:
The main reason for using the ‘Configure MFP Devices’ tool is to configure Scan Profiles in
a large number of network MFP devices. However, it can be used to configure individual
devices as well.
The tool is accessed by selecting Configure MFP Devices from the Tools menu.

Interactive Configuring of Scan Profiles
OKI MC561 and MB491 devices support up to 99 Scan Profiles. Each profile is numbered
from 01 to 99.
To set up Scan Profiles in a particular device, select the device from the dropdown list and
click the Get from Device(s) button.
The Scan Profile settings are displayed as a table. The settings displayed depend upon
the selection of the View dropdown list. “Simple” displays only the most important profile
settings. “Advanced” shows all of the settings associated with the profile.

Adding a Scan Profile
You can add a scan profile to a particular device by clicking the Add button when that
device is selected in the Device dropdown list. Provide the desired values for the various
settings. PSV automatically provides the next available Id. Click Apply To Device to add
the new profile to the device.
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Editing and Deleting a Scan Profile
You can make changes to a scan profile by clicking in the Id column of the profile you
want to change. The settings shown depend upon the selection of the View dropdown list.
When working in the Advanced view, it is assumed the user has an understanding of what
each option represents. Not all combinations of profile values are acceptable. For
example, FTP encoding options are not applicable with the HTTP protocol. In some cases
the program will automatically adjust obvious mistakes. In other cases, the MFP device
may reject a wrong combination of options.
After making any changes, click the “Apply To Device” button. This will save the Scan
Profile back to the device. PSV does not save device scan profiles in its database. You
can delete a scan profile by clicking the “Delete From Device” button.

Scan Destination: Share Folder or a Server:
Scan Profiles may specify a server or shared folder that needs to be configured separately.
Please make sure to correctly configure security access rights, including username and
password as applicable. The available protocols are:
 CIFS: Windows Sharing
 FTP: Windows IIS (Internet Information Server) support it; In case of “anonymous”
access FTP server still expect username “ftp” and password that includes character
“@” like in email address.
 HTTP: Be aware that IIS 7 or newer (Windows 2008 and Windows 7) do not support
“anonymous HTTP PUT” so Username and Password must be provided.
Make sure to enter correct port number for the selected protocol. Default choices are
provided next to “Port No.” field on the form.
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Using Scan Templates:
Scan Templates can be used to save scan profile settings to the PSV database. A scan
template can be associated with a particular device or a group of devices. When the
template is a device template, it essentially provides a way to save an individual scan
profile to the database. It is when a template is a group template that it becomes more
useful from a configuration standpoint. When a group template is used it gets applied to
all compatible MFP devices in that group. This allows you to easily configure the same
scan profile to a number of devices.

Adding a New Scan Template:
To add a scan template, select an individual MFP device or printer group from the Device
dropdown list and click the “Add” button. If the “Add” button is not shown, click “Show
Templates”. If an individual device is selected, then the template created is a device
template for that particular device. If a printer group is selected, then the template
created is a group template for that group. Provide the desired values for each setting.
When you have made all of your changes, click the “Save Database Template” button
instead of the “Apply To Device” button.

Editing Scan Templates:
Editing Scan Templates is very similar to editing Scan Profiles. One visual difference is the
addition of the ‘Template From’ column shown before ‘Id’ column. This column indicates if
the template is a device or group template. Both device and group templates apply to
individual devices. This column distinguishes between the two. Only group templates will
be shown for a printer group.

In the following example, Scan Template with Id ‘04’ is assigned to this one individual MFP
devices, and other three templates (‘02’, ‘03’, ‘10’) are from ‘Group: All’. That is they
apply to the selected device and to all compatible MFP devices.
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Applying Scan Templates
For the scan settings represented by a scan template to be used by a particular MFP
device, the scan template must be applied to that device. To do this:
1. Select the individual device or printer group where the template has been saved
from the Device dropdown list.
2. Click in the Id column of the template you want to apply.
3. Click the “Set with Templates” button. If a device template is selected, only that
device is updated. If a group template is selected, the template is applied to all
devices in that group.
Once the program has completed this, you should see a new profile for each device where
the template was applied. You can confirm this by selecting a device from the Device
dropdown and clicking the “Get from Device(s)” button.

Hierarchy of Group Templates
Besides the default group ‘Group: All’, devices can be organized into any number of
groups. This allows printers to be grouped by region or department for example. Scan
Templates can be assigned to those groups, and then applied to each printer in the group.
In next example, Scan Template ‘04’ is defined for ‘Group: Marketing MC561s’. It applies
to all compatible devices in that group. Care should be taken so that all templates have a
unique Id. When there are scan templates with same “Id” assigned to both group and
individual device, the template for the group is used. This is to make sure that common
templates are always visible on all devices in the group, and avoid accidental “hiding” of
common templates.
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Using PSV “Attributes” to Customize Scan Templates:
Scan Templates allow you to establish the same scan profile in a number of MFP devices.
However, there may be cases when you want a part of the scan profile to be different for
each device. You could set up a different scan profile for each device, but this would be
time consuming to implement and configure. The “Configure MFP Devices” tool allows you
to use PSV “Attributes” as part of a scan profile.
PSV Attributes are named values that are assigned to individual print devices and saved in
the database. For example, each device can have an attribute named “StoreNumber” that
a company uses to identify individual store locations. PSV Attributes can be included in
interactive reports, email alerts, and in tools such as “Configure MFP Scan Profiles”.
Here’s how it works:
In a Scan Template, a special marker with attribute name inside of { } can be used.
When the program finds these characters, it tries to find an Attribute with the same name
for the device the template is being applied to. If such an attribute exists, then the
program replaces the attribute name with the attribute value. This new value is used
when setting up the profile for that device. The profile is customized to the device even
though the same scan template is used.
‘Address’, ‘Name’ and ‘Location’ are standard attributes. The values for these come
directly from the MFP device. They do not need to be entered by the user.
For example, a Scan Template can have a Filename set as:
“Order_{Address}_{Name}_#n”. When this template is applied to a device with Address
“192.168.1.100” and name “OKI-MC561-221037”, the Scan Profile created in the device
will have Filename setting “Order_192.168.1.100_OKI-MC561-221037_#n”. The Address
attribute has been replaced with the IP address of the device. The Name attribute has
been replaced with the actual name of the device. The “#n” is replaced by MFP device
with number of scan (to make filename unique) at the time of scanning.
Another example, stores may submit a daily sales summary. A scan template can be set
up so that all stores use the same FTP site. The Filename setting can use an attribute so
that the name of the file created indicates the store the report is from. The Filename field
in the template can have the value
“Sales_{StoreNumber}_#d”. When the template is applied to a device, the program
will try to use the attribute “StoreNumber” for that device. The names of the scan file
created by different MFP devices will all have the correct store number in the filename
making it easier to identify the source of the file.
Editing and viewing of Attributes can be accessed from “Configure MFP Devices” by
clicking the “Edit Attributes” button. Be sure any attribute name you use in a scan
template match exactly the actual attribute name.
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Attributes can also be imported from a CSV file, from “Printers | Import Printers and
Attributes” tool.

Date/Time and Document Number in Filename:
To help make each scan file name unique, MFP device can insert current date/time and
scan number to each scan file. For example, ‘Filename’ can be defined in Scan Profile as
‘SalesSummary_100_#d_#n’
#d is replaced by current date/time by the MFP device when scanning.
#n is replaced by a number that increments for every scan, to form a unique filename.
Using the previous example, a scan document created by an MFP device would have a
filename like “SalesSummary_100_052912133702_00001.pdf”.
The date/time in the filename is encoded by MFP device as “MMDDYYhhmmss”.
The date in the example is “29-May-2012 01:37:02 PM”.

Show State:
The tool keeps track of all ‘Set with Templates’ actions, with date and status. By selecting
a device or group and clicking “Show State”, you get the current configuration state of
selected devices. “OK” indicates success. “Not Set” means the device was not responding
at the time configuration was tried. If configuration failed, the error is displayed in red.
The ‘address, name, location’ is a link to an individual device. It is a convenient way to
directly access a device to configure it again, view current configuration, or edit attributes.
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Show Logs
Click on “Show Logs” button presents a list of attempts to configure devices in the
selected group.

Using a Scan Profile from the MFP device’s Control Panel
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Press the “Scan” button.
Select “Network PC” using the up and down arrows on the control panel.




Press the “OK” button.
Use the up and down arrows on the control panel to select “Select Profile” from the
menu. Then, press the “OK” button.



The Profile List will be shown.
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Use the up and down arrows to select the desired Scan Profile.
Press the “Start” button on the control panel to start scanning.
The scan file is sent to configured file server

Group Configuration
Only available in the PSV Enterprise edition, Group Configuration is a more advanced way
to configure devices remotely by using the parameters from one device to configure a
group of similar devices.
Group configuration uses an XML file as a “Template” to remotely set up groups of devices.
Currently there are 4 sample templates included with PSV.
To use Group Configuration: Click Tools from the main menu and click Printer Group
Config from the drop down box.

2. Select a template from the drop down menu.
3. Select the Target Group of devices that will receive the new configuration.
For a list of devices in each group click Show printers. Select the devices that will
receive the configuration by clicking the check boxes in the Select column.

The “paper source” configuration from the origin device can be modified before applying
the configuration to the group selected.
4. Make desired configuration changes and click Apply.
There are other sample Group Configuration templates provided that perform various
tasks.
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Configuring Static IP Address
PSV Enterprise Edition includes a tool for automating the configuration of IP addresses. It
is accessible from the main Tools menu.
It is frequently requested to configure a print device to use a static IP address, by using
some “address scheme”. Typically, printers have “fixed last octet” inside of a subnet.
This tool helps find matching printers inside of selected subnets, detects current
configuration of IP address (static, dynamic), and allows changing from dynamic to static
and vice versa.
The tool makes it possible to configure all (compatible) devices with the parameters as
per policy, as well as to configure individual devices with desired values. The tool can be
used to re-configure all devices to desired default values with one mouse click. Specific
examples of how this feature can be used are:



Configure One: Gateway, Subnet - Change IP configuration parameters for one
device at a time. The parameters available are: Static or Dynamic IP Address
(DHCP disabled or enabled) selection, Gateway address and Subnet mask.
Fix many: Gateway, Subnet – Change Gateway address and Subnet mask to
desired value.

Configure Static IP Address:
This tool helps to automate the configuration of gateway address and subnet mask. These
options can be configured manually using a browser and the device’s embedded web
forms. PSV helps automate the configuration of such options.

The “Configure Static IP Address” page is available only to members of the PSV
“Administrators” group. It is accessed by selecting “Configure Static IP Address” from the
Tools menu.
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This tool can help you configure print devices to desired static IP addresses in each
network subnet. A typical situation is:
 There is one print device of desired type in each network subnet,
 When connected to network the device gets a new dynamic IP address assigned
i.e. from DHCP
 Expectation is that the print devices have predictable static address within of
each subnet, to be used for configuring print queues
Here are few key concepts to help understand using the tool:
 All PSV data are stored in a database
 PSV organizes printed devices in “printer groups”. Each print device can be a
member of multiple printer groups.
 Discovery of print devices is done for a range of IP addresses, called “subnet”
 A subnet can be associated with a printer group, so when a print device is
discovered in a subnet it is automatically added to the printer group
 Each printer device and printer group can have “attributes” associated with it.
Those are the name/value fields provided by PSV users and stored in database.
 Addresses of printed device as well as printer groups and subnets can be
“imported” from CSV files, along with related attributes, and saved into
database.
 Attributes as well as other data can be edited by PSV admin by using a web
browser.
PSV “Configure Static IP Address” tool (“Tool”) can:
 Discover print devices in a subnet
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Inspect them for current configuration
Find printer group associated with the subnet
Read desired static IP address for the subnet from the database as an attribute
of associated printer group
Configure print device to desired static IP address
Update the database with new IP address of the device

The tool can also inspect previously discovered devices that are already in the database,
and update them based on attributes of related printer groups.

Getting Prepared:
Formulate a schema for setting IP address of connected network printers in each location.
For example, the last octet of the subnet address of all printing devices will be 23 and it
will have static IP address.
Select the list of printers that need to be configured to the static IP address. If PSV is
already used to discover and monitor the devices, use PSV Printers List and Printer Groups
to create a list.

Preparing the CSV file:
Create a CSV file, which lists down the address range (referred to as subnet), in which
Printer Model is to be searched.

The first row must be the header row (case sensitive) and should contain the names for all
attributes that are to be imported. A short description of the attributes required for
configuring device settings follows:
 “IP range”: Defines the IP address range for a subnet. It is also used as name of
the printer group associated with the subnet. The last octet contains the start
(including) and end (including) addresses in the range. For example:
172.31.19.50-250 means from address 172.31.19.50 to address 172.31.19.250.
 “PrinterIP”: Attribute for desired static IP Address of the device. This value
should be complete, for example: 123.45.67.89
 “SubnetMask”: Attribute for Subnet Mask to be set in the device, for example:
255.255.255.0
 “DefaultGateway”: Attribute for Default gateway to be set in the device.
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Importing a CSV file to create Subnets in PSV:
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Launch PrintSuperVision from a browser
Login as Administrator. Default username is: “admin” and default password is:
“password”.
Navigate from Menu: Printers to Import Printers and Attributes.
Click the Browse button and specify the path to the Import file in csv format.
Click Preview, to see the contents of the file in tabular format.

Click “Import”, to start Importing of subnet.

During import, PSV will add a subnet for each row in the csv. The range of IP addresses
for this subnet will be derived from the value of the “IP range” field in the csv file.
PSV will also add a Printer group to correspond to the subnet. The name of the Printer
group will be taken as the value specified for “IP range”. All other fields specified in csv
file will be added as attributes of this Printer group.

Discover printers in the subnets:
Click on the Discovery link that appears on the page after subnets were imported, or from
the menu. Navigate to Printers then to Discovery. Click the Start Discovery button.
This will discover all printers present in the subnets.

Configuring PSV for IP Address Configuration
From the main menu, navigate to Tools, then to Configure Static IP Address. This
page provides the tool that helps find matching printers inside of selected subnets, detects
current configuration of IP addresses (static, dynamic), and allows changing from dynamic
to static and vice versa.
The Configure dropdown menu on the page lists the manner in which this tool allows
Configuration of supported devices.
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The following options are provided:


Introduction: Gives a brief description of tool and provides link to “Import” for
importing CSV files and “Printer group” to Edit the attributes.



Supported printers from all subnets in database: Inspect configuration of each
active supported printer from database, and change to static IP address for selected
devices based on attributes of printer group associated with the subnet in which the
device is located.



Discover single subnet: Discover compatible devices in selected subnet; for selected
print device inspect current configuration; change configuration of selected device.
Configuration settings can be assigned manually or accepted from attributes of the
printer group.

Configure Supported Printers from all subnets in database:

Clicking Inspect devices from database button tells PSV to inspect all compatible
printer devices that are already in the database. Details of printers in subnets are
displayed in the table as shown below.

The following is a description of a few columns in this table.
 Current Address Type: Current value of address type (Static/Dynamic) as
retrieved from web page of the device is displayed here.
 Desired Static Address: If selected for configuration, this is the static address
at which printer will be placed. Value for this field is retrieved from the printer
group attribute “PrinterIP”.
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Desired Gateway Address: If selected for configuration, this will be Gateway
Address. Value for this field is retrieved from the printer group attribute
“DefaultGateway”.
Desired Subnet Mask: If selected for configuration, this will be Subnet Mask.
Value for this field is retrieved from the printer group attribute “SubnetMask”.
Configure: User is allowed to select printer(s) to be configured, using the
checkbox in this column.

After selecting printer(s), when user clicks “Configure selected printers”, the tool initiates
configuring address settings for each of the selected printers, showing progress on the
page.

If the group does not have the desired attributes, PSV detects it, and provides a link to
Add Attributes:

Click Add Attributes to edit the attributes, and click save.
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Discover single subnet:
When a user selects the Configure option for “Discover single subnet”, the following page
will be rendered.

The “Subnet Address to Scan” dropdown provides a list of all subnets, including those that
were imported from a CSV file. Clicking on the Start button will initiate discovery of
matching print devices in a selected range of addresses for the subnet.

Compatible print devices are presented as a drop list. The Get Configuration button will
display current configuration of selected devices (static/dynamic).
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The “Current Configuration” of a device is retrieved from the printer’s web page. If
current configuration is Dynamic IP, the page shows desired configuration settings for
changing to static IP configuration.
 Desired Static Address: Default value for this field is retrieved from the
printer group attribute “PrinterIP”.
 Desired Gateway Address: Default value for this field is retrieved from the
printer group attribute “DefaultGateway”.
 Desired Subnet Mask: Default value for this field is retrieved from the printer
group attribute “SubnetMask”.
Note: If the printer group associated with the subnet does not have values for these
attributes, default values for desired settings will be populated from those specified in the
device web page. Clicking the Update button tells the program to check availability of
the address, then goes for setting new address, and discovering devices on the selected
subnet, to update printer in database with new address.
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Configure Dynamic IP
When current address is “static”, the tool provides an option to “change to dynamic IP”.

When selected, this changes the configuration of the device, and then starts re-discovery
of the selected subnet to find a new address of the device assigned by DHCP.
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Configuring Static IP Addresses:
For technicians (non-PSV Admins) who are installing or replacing printers onsite a
separate tool is provided called the “config static address tool”. The tool is a subset of
features, (or a part of) the “Public Web Site” feature configurable from the PSV Setup tool.
This “public” web tool can only discover addresses on local subnets where the web
browser is coming from, and it can only change an address from dynamic to static address
as indicated by the user attributes that were imported from CSV file.
It works the same as the full-featured tool, but it does not have standard PSV menus. In
addition, this tool is available as option in “Public” web site in PSV EE. Please refer to
“Creating public website”, for the steps to create a public web site in PSV EE.
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Desired values are retrieved from user attributes associated with the printer group. All of
the values displayed are read only, and cannot be changed by the user.
Click the Update button, to change printer settings to desired Address settings.

Enabling “Configure Static IP Address” in Public Web Site using PSV Setup
tool:
The “Public Web Site” feature can be used in “internet” and “intranet” configurations.
When used in an “internet” configuration, it typically receives data from other PSV server
sites or PSV Agents. When used for “intranet” access, to provide limited functionality to
all users in the network, not only those who are managed in PSV.
The “Configure Static IP address” tool is one such feature that can be enabled/disabled by
checkbox. Please make sure to unselect this checkbox if PSV Public Web Site is used in
“internet”.
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When the “Configure Static IP Address” tool is enabled, the main page on the public web
site includes a link to this tool.

Configure One: Gateway, Subnet
PSV allows you to read the current configuration settings in place for one print device and
change it. The “Configure One: Gateway, Subnet” page allows you to control which
devices are configured and which settings are retrieved.
 IP Address – Enter the IP Address of the device you want to configure in octet
format such as 12.34.56.78.
 Non-default password - If the device has a web password that is not default,
enter it here.
 Click the Get Model, Gateway, Subnet button after you have made your
selections for IP Address and Non-default password. PSV will then connect to the
appropriate device and get the current values and show a form to change the
values.
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Enter the correct Gateway address – for example 172.31.19.1 – and Subnet Mask –
for example 255.255.255.192 – and click the Set Gateway, Subnet button. The
program will make the necessary changes in the device. Click Get Model,
Gateway, Subnet button to verify the changes.

Fix Many: Gateway, Subnet
PSV allows you to fix the configuration settings for all print devices that are wrongly
configured and change it. The “Fix Many: Gateway, Subnet” page allows you to control
whether to skip devices that are already and skip devices that failed. Based on the results
of the operation, you can use the “Configure One: Gateway, Subnet” option.
 Addresses CSV file path – Enter the file path where the CSV file is located. If
Import Schedule option is selected, PSV will prepopulate this field.
 Non-default password - If the device has a web password that is not default,
enter it here.
 Skip Configured – Select this if you are running the program again to fix some
devices that did not respond earlier. By default, this is selected to avoid duplicate
setting of the devices that have already been configured.
 Skip failed – Select this option if you know that the devices that failed are not in
active service.
 Show Log – This button shows the results of the operation.
 Show Status – Shows the status of the devices current configuration.
Click Fix Gateways and Subnets button to fix the configuration settings for all print
devices that are wrongly configured.

Click Show Status button to view the status of the operation.
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Click Show Logs button to view the log of all the actions taken.
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Supplies Ordering
Both editions of PSV provide the option to order supplies on-line directly from the
application. An Admin has several options to help make the supplies ordering process as
easy and efficient as possible. It is also understood that not every organization is setup to
order supplies on-line, so an option to disable on-line ordering is also included.
You can order supplies for your Oki devices at any time by:
1. Selecting Tools / Order Supplies from the main menu.
The options in the Order Supplies section help users to:
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Search for supply item
Create an order manually
Configure the URL for all on-line ordering
Edit PSV’s database of supplies
Disable on-line ordering

Searching for a supply item
To search for an item, click the Search radio button, enter a description of a desired item
and click the Next button. PSV will search its database for related supply items.
Select Printers, then Items button
The Select Printers then Items feature provides a list of the devices that PSV is
monitoring so that you can first choose the device that needs supplies, then indicate the
quantity of the item to purchase.
1. Check the “Select Printers then Items” radio button and click Next.
A list of monitored devices is displayed.
2. Select the desired device by clicking the check box and click the Next button.
A list of supply items related to the device will be displayed.
3. Add the desired order quantity and click Next/Order On-line or Next/Print to
simply print your order.
The default e-commerce site is http://esales.okidata.com, which can be changed to any ecommerce site and will be discussed later in this section.

Items for Local Printers:
Click this option for a list of supply items that go to the devices that PSV is currently
monitoring. Use the list to obtain a description of the supply item and Oki part number
needed to place an order. Click Next/Order On-line or Next/Print to simply print your
order.
All Available Items
Click this option to display and print the entire database of supply items.
1. Enter a quantity of the item desired
2. Click Next/Order On-line or Next/Print to simply print a list of supply items

Customizing Supplies Orders
If on-line ordering is not desired in your organization, you have the option to manually
create a printed supplies order page that contains the supply part number, description and
quantity desired.
1. Click the Customize Order option.
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2. You can add information to each printed supply order page by typing information in
the To, From, Subject and Text fields template. Information typed will be added
as a header to each supply order page.
3. Select the Print Header Enable check box to add the pre-configured information
to each printable supplies order page.

4. Click Save to return to the Order Supplies page
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Configuring the Supplies List
There are four options to configure the supplies list that is integrated into the PSV
application:





You can use the existing supplies list which obtains its information from
http://esales.okidata.com
You can edit and add to the existing supplies list
You can point PSV to another list
You can disable supplies ordering entirely

Default Button
Selecting Default continues to use the supplies list that is provided with the PSV
application.
As an added convenience you may want to allow your users to verify the ordering
information before linking to an e-commerce shopping cart. Click the Verify Before
Shopping Cart check box for that option.

Enabling / Disabling Online Supplies Ordering:
To enable or disable on-line ordering entirely, select or deselect the Online Link check
box. Checking this box will add the Order Online button to the printer status page (and
system wide) and allows users to order supplies on-line from many different areas.
Unchecking the box removes the Order Online button system wide and eliminates the
ability to order supplies on-line entirely.

Editing the Supplies List:
The default supplies ordering information list can also be customized. Editing the Supplies
List creates an additional XML file that contains the default supplies ordering information
plus any edits or additions you make to the default file.
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Selecting the Edit Supplies List radio button tells PSV to use your edited list (versus the
default list). Clicking on the Edit Supplies List link (displayed in blue) takes you to the
area where additions and edits can be made and is displayed in the following screenshot.

1. Click on the globe icon displayed in the Edit column to edit existing information or
scroll to the bottom of the list to add information and click Add Item

2. Enter or edit the name and description of the supply item in the Name field. Since
PSV uses the contents of the Name field as search criteria, it is important to indicate
the model number of the device that the supply item is related to in that field.
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3. If you plan to use a different e-commerce site than esales.okidata.com, enter the
appropriate web site address in the URL field. If the URL field is left blank, the supply
item will be unavailable to order on-line. The description of the supply item however
will be available to print when creating a printed supplies order page described earlier.
4. The Picture field is used to display an image of the supply item when viewing the
supplies list. Enter an appropriate link to the desired image. Leaving the field blank
will still display a description and part number of the item in the supplies list, but no
image will be displayed.
5. To edit the item’s part number or SKU, enter the new number in the Code field.
6. Click the Save button to save your changes.
Note: This procedure must be replicated for each supply item if you intend to use an ecommerce site other than http://esales.okidata.com. As an alternative to editing each
supply item manually, you may edit the Supplies List XML file that PSV uses for this
purpose.
You can locate the file in the following folder and perform a global search and replace on
the old / new URLs. The XML file is stored in
C:\Program Files\PrintSuperVision\www\..\data\supplies11.xml

Selecting an Alternative Supplies List
You can also point PSV to any other compatible XML file that contains custom supply
descriptions and part numbers. Enter the appropriate URL of the file in the box and click
the associated radio button.
Use the XML file mentioned above as a template when creating a custom supplies list.

Disabling Supplies Ordering:
To completely disable the ability to order supplies either on-line or by manually printing a
supplies order page (discussed earlier), click the Disable Supplies Ordering Button and
click Save.
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Supplies Ordering Calendar:
To help you plan ahead when ordering supplies, PSV offers a monthly supplies calendar
view that indicates (based on historic usage) when a supply item will run out and when a
maintenance item needs to be replaced. And with your favorite picture, you can print the
calendar and hang it on the wall.
1. Click Tools from the main menu and Calendar from the drop down menu.

2. Select the Picture radio button if you wish to display and/or print an image on the
calendar.
3. Select a date range for the calendar
4. Check the Show Expected Empty From Supplies Report and Show
Maintenance Items if you wish to be reminded of both supplies and maintenance
items that need to be replaced (such as fusers and transfer belts).
5. Click the Show Calendar button to generate your supplies ordering calendar.
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Reporting
PSV can generate several reports that identify supplies use, predict toner replacement
dates, indicate pages printed, export device properties and so on.
Most reports can be displayed or saved in various formats such as HTML (Web), XML,
Excel, CSV or Text files.
Most reports can be scheduled to be periodically generated and delivered by email.
Reports available depend on the PSV edition installed and user access rights.

Available Reports:
Report

Description

Total Engine Pages Count

Reports the total page count of the selected
device/s. The total page count is a reliable
counter which is never reset. The total page
count includes many jam counts also with the
exception of feed jams.
Reports the color and mono page count of the
selected device/s. The color and mono page
counts are computed by the printer
controller. If the controler board is replaced,
or some other reset is done, the counter
values wil be reset to 0. The color and mono
page counts do not include many jam counts.
Reports the color, mono and total page count
of the selected device/s. The color and
mono page counts are computed by the
printer controller while the total page count is
computed by the printer engine. If the
controler board is replaced, or some other
reset is done, the counter values wil be reset
to 0.
Reports the equivalent A4/Letter impressions
with color and mono breakup. The
equivalent impressions account for printing in
different media sizes such as banner or
tabloid or duplex, and calculates the
equivalent A4/Letter impressions.
Reports the MFP Print with color and mono
breakup, Scan, and Fax counts. These are
reported only for some OKI devices.
Reports the page counts by each tray. The
tray counts reflect the sheets printed, and
does not account for duplex printing.

Color, Mono Usage Page Counts

Color, Mono, Total Page Counts

Equivalent Impression Counts

MFP Page Counts
Page Counts by Tray
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Configuring Report Properties:
Before selecting and scheduling delivery of an individual report, you have the option to
add or delete many different attributes and properties that are available for reporting.
Once the properties and attributes are saved, PSV creates a universal report configuration
that applies those saved properties to most of the reports (exceptions include the
Windows Print Job Logs report). You may edit the saved properties at any time.
To select reporting properties and attributes:
1. Select Reports from the main menu
2. Click Reports Properties from the drop down menu

3. Select desired device properties from the All Properties column
4. Click Add to move them to the Selected Properties column. If you make a mistake,
click Remove and the property will be placed back in the All properties column.
5. Once you have added the desired properties to the report, you may prioritize them
by clicking the Up and Down keys. The order in which the property is listed is the
order the column will appear in each report.
6. Click the Save button to save your selections.
Alternatively, four pre-configured report formats have already been created and may be
selected by clicking the Load Form button. Select the desired format from the drop down
menu and click the Load button. Be sure to click Save.

124

Printing Report:
This report displays the color and mono page counts on a monthly or daily basis. This
report is available only for a select group of printers.
For OKI products, the devices return many counter values.
description of the various counters.

Following is a brief

Total Engine Page Count – This count is the total number of pages printed by the
printer engine, and includes pages jammed (other than feed jams). For duplex printing,
this counts both the faces, i.e., 2 pages. This value is a life count and will always be
increasing.
Color Usage Page Count – This count is the total number of color pages printed by the
printer controller, and does not include most jam conditions. If the printer controller
board is replaced or some other formatting operations are performed, the counter value
will be reset to 0. For duplex printing, the color or the mono page count is incremented
based on the content of the front or back face of the page.
Mono Usage Page Count - This count is the total number of mono pages printed by the
printer controller, and does not include most jam conditions. If the printer controller
board is replaced or some other formatting operations are performed, the counter value
will be reset to 0. For duplex printing, the color or the mono page count is incremented
based on the content of the front or back face of the page.
Tray Page Count – This count is the number of sheets printed from each tray and
includes pages jammed (other than feed jams). For duplex printing, this counts one face
only, i.e., 1 sheet. This value is a life count and will always be increasing.
Scan Page Count – This count is the number of scanned document pages, and does not
include most jam conditions. If the scanner controller board is replaced or some other
formatting operations are performed, the counter value will be reset to 0. Breakup of the
scanned pages by ADF and glass is available.
Usage Report – This report includes total as well as breakup of the page counts
accounting for different media sizes and color / mono as well as simplex / duplex printing.
The total counts are adjusted for equivalent A4/Letter values. For some devices, the
Usage Report feature has to be enabled in the device, and only then this report will be
available.
Fuser Count – This count is the number of pages passing through the fuser unit adjusted
for paper length. In view of that, the fuser count can provide an equivalent page count
when A3 or banner printing is done. The value will be reset to 0 when the fuser unit is
replaced.
MFP Usage Report – This report provides a summary of the Print, Scan and Fax counts
of MFPs with detailed breakup of each.
The “Device” drop-down list controls which devices page counts will be shown for. The
contents of this list can be filtered by entering text in the edit field at the top of the list.
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The contents of the list are updated as you enter text. Only items in the drop-down list
that contain the text will be displayed. For example, if you only wanted the list to contain
OKI model B710, you could enter “B710” in the edit field. Filtering is done by searching
the text of each list item. If the list item contains the text, it is kept in the list. If it does
not, then it is removed from the list. As another example, if you enter “50” in the edit
field, this would match the OKI C9650 if it is in the list, but it would also match a device
with IP address 12.3.44.50 if such a device was in the list.

The “Report” drop-down list controls which page counts are shown in the report.
The “Interval” drop-down list controls if the counts are reported by month or by day.
By default, the Printing Report shows the total counts for all devices in a group - when a
printer group is selected i.e. the counts for individual printers within the group are not
shown. If the counts for individual printers are needed, check the “Device Usage”
checkbox.
The “Report Properties” link allows you to change the printer properties that are shown for
individual printers. The Report Properties are displayed only when the “Device Usage”
checkbox is checked.
The Printing Report can be configured so that the report is sent automatically to PSV users.
In order to do this, certain email settings must be configured. The “Configure Email” link
transitions to the screen where the email configuration is done.
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When the Device Usage checkbox is checked, the counts for each device are shown in
addition to the totals.

The Printing Report can be scheduled to run automatically by clicking the Schedule
button. The report is emailed to selected PSV users when run this way.

Scheduling a report can be added by using the following form.

Users can view the Schedule log for the Printing Report by clicking on the Schedule Log
button. An entry is added to the log each time PSV attempts to run a scheduled report.
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Low Supplies Report
The Low Supplies report is a very simple way to identify devices that are reporting toner
remaining levels equal to or less than the user defined percentage.
1. From the main menu click Reports and select Low Supplies Report from the drop
down menu.

The process of scheduling the Low Supplies Report consists of the following:
 Managing the list of print devices in the PSV database
 Configuring printer groups
 Defining Low Supplies Report parameters
 Creating Schedules for Low Supplies Report
This report lists devices with a consumables value lower than the configured value during
the specified period. The report includes only supplies that are 'detected' to be 'low' in
the interval since the selected date/time. This means a supply will be reported low only
once – no duplicates - as long as the selected intervals do not overlap.
The fields in the report and their brief description are listed below.
 Detected Low Since: Enter the date from which the Low Supplies Report is to be
run. By default, PSV selects 1 week from the current date for interactive reports,
and for scheduled reports show the last time the report was sent by PSV.
 Device Search: If multiple devices are monitored by PSV, you can enter the
specific model name that you are interested in this optional field.
 Printer Group: Select All or a specific Printer Group. The dropdown list shows all
the Printer Groups that are configured in PSV. Select the group you are interested
in. For scheduled reports, you can select multiple schedules based on each group.
 Low if Value <=: Enter the desired threshold parameters for the supplies such as
toner, drum, belt, and fuser. Supplies with a reported value below this level will be
included in the report. Usually, the belts and fusers have a longer life than the
toner and the drum.
 Show: Select the parameters of interest. The Device Name and Device Location
are fields that are configured in the printer’s device web page. Current capacity of
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the supplies as well as the suggested replacement capacity is listed. By default,
PSV lists the largest available size of the replacement consumable.
Format: Select the report format - which includes HTML (Web), CSV (Excel), and
XML.

A sample Low Supplies Usage Report is displayed below.
To view additional details of a specific device, click on the Printer Log hyperlink.

The Low Supplies Report can be scheduled to be sent to different users or user groups
and a number of reports can be scheduled with different parameters for various printer
groups.
Select Reports | Low Supplies Report and click on Schedule. If Schedules have already
been configured, this page will show the current schedules. To add a new schedule, click
on Add.

The Date, Time, and Recur Interval settings control when and how frequently the report is
run.
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The email Subject line includes the Description field in the reports sent.
The current list of scheduled reports is accessed by selecting Reports | Low Supplies
Report | Schedule. You can edit the individual report settings. If you make any changes,
be sure to click the Save button.

Toner Changes Report
The “Toner Changes” Report shows the dates of the last toner cartridge replacement for a
group of devices and indicates if there was any toner remaining at the time of
replacement. This report is particularly helpful in identifying wasted toner as a result of
changing the cartridge too soon.
Note: The Toner Change Report is not available in the Professional Edition.
1. Select Reports from the main menu and Toner Changes Report from the drop down
box.

2. Enter a range of dates or click on the calendar icons to select dates.
3. Select a group of devices to report on
4. Select a report format and the method to display results; by month or by various table
sizes to make the data more readable.
5. Indicate either HTML or Excel format and click Show to generate the report
Additional details for toner replacement are available by clicking the toner type links
(highlighted in blue). This presents a sub-report that can help you pinpoint toner
remaining at on a particular date.
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Scheduling a Toner Change Report:
A Toner Change report can be scheduled to run periodically and automatically delivered
via email to an individual or group.
1. Click the Schedule button
2. Click the Add Toner Changes Report button
3. Select a starting date and time, select a recurring interval for the report to be
generated and sent, indicate email recipients and click Save.
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The toner changes report will be generated and sent to the recipient on the dates and
times indicated.
Note: For added convenience the Schedule Logs button located next to the Schedule
button provides a quick way to see if/when the Toner Changes Report was generated and
sent via email.
1. Click the Schedule Logs button
2. Indicate the desired date range
3. Select Toner Changes Report from the drop down menu
4. Click Show to run the status log

Supplies Usage Report
The Supplies Usage report displays current levels of toner as well as drum, transfer belt
and fuser usage.
 The report can be created for a group of devices or a single device
 Report data can be displayed as an HTML table or chart
 Data can be imported into Excel
 Data can be presented in XML format
The Supplies Usage report helps you to plan your supply purchases by predicting when
consumables (supply items) will run out. A forecast report is also available that predicts
the consumables that will be required over a period of time based on the current usage.
1. Select Reports from the main menu and Select Supplies Usage
2. Select an individual device or group of devices from the dropdown menu.
3. Select the Supplies you wish to view and the desired format of the report.
4. Click the Show button to run the report

132

After running the report with default settings, you may choose to customize the report:
1. Click the Customize button

2. Select any of the following options
% Remaining:
 Indicates the percent of each supply item that is not used
% Used:
 Indicates the percent of each supply item that has been used
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Change by Date:
 Indicates the anticipated date the supply item will run out
Days Remaining:
 Indicates the anticipated number of days remaining before the supply item runs out
Start Date:
 The date that PSV started monitoring the device
Start Value:
 The consumable value recorded when PSV started monitoring the device
Current Value:
 The consumable value recorded at the time the report is generated
Maximum Count:
 Displays the maximum design value of the consumable. This value is used in
calculating the remaining percentage of the consumables.
Report if data is not older than XX days:
 Allows data from inactive devices to be filtered out
Min. days for Forecast xx days:
 This value which by default is 7 days shows the consumables forecast for the
number of days. If lower or higher number is desired, select a suitable value.
Show if less than XX% or less than XX days:
 Prints values in red text to stress the importance of replacing supplies that are
almost out. Use a higher value if you need more time to react. Use a lower value
if you are only concerned with critical situations.
3. Click Show to run the Supplies Usage Report
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A sample of the Supplies Usage Forecast Report is shown below which indicates the
consolidated list of supplies that need to be replaced in the next few days.



The details of the forecast report show additional information about the device and
the consumables data.

Scheduling a Supplies Usage Report
Like all PSV reports, The Supplies Usage Report can be run automatically and sent to a
user by clicking the Schedule button.
1. Click the Add Supplies Usage Schedule button
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2. Select a starting date and time, select a recurring interval for the report to be
generated and sent, indicate email recipients
3. Choose formatting options
4. Click Save
Click the Schedule Logs button to verify that reports are being generated and sent
according to the schedule specified.
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Printed Pages Report
The printed pages report displays the number of pages printed over a period of time by an
individual device or by a group of devices. Like all of PSV reports, you can use the
Reports Properties feature prior to defining the parameters of the report to add
additional information to the report.
1. Select Reports from the main menu
2. Select Printed Pages Report from the drop down box

3.
4.
5.
6.

Select a single device or group of devices
Enter a date range for the report
Choose the desired format type
Indicate whether you would like PSV to calculate average pages printed per day and
/or to include a graph or chart of the pages printed.

Note: If the Chart option is selected, the “Pages Printed” report can be graphed using
several different charting formats such as pie charts, bar graphs and line graphs.
7. Click the Show button to run the report.
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A sample report is displayed below.

Scheduling a Printed Pages Report:
The Printed Pages Report can also be automatically created and sent to a user at
predetermined intervals.
From the Printed Pages Report screen:
1. Click the Schedule button
2. Click the Add Printed Pages Schedule button
3. Select a starting date and time, select a recurring interval for the report to be
generated and sent, indicate email recipients
4. Choose formatting options
5. Click Save
Click the Schedule Logs button to verify that reports are being generated and sent
according to the schedule specified.

Exporting Device Properties and Attributes Report
The Export Printers Data option makes it easy to view and save a list of all device
properties and attributes for each device. You control the content included in the report
by selecting the desired properties and attributes from the Reports Properties page
(Select Reports from main menu and Reports Properties from the drop down box to
configure the report).
Select Reports from the main menu and Export Printers Data from the drop down box.

Note: if you have more than one PSV site running, you may also choose the appropriate
PSV Site from the drop down box.
Select the desired file format for report and click Show.
You may also choose to have the report automatically emailed to you by clicking the
Schedule button.
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The Schedule Logs button allows you to view a running log of all scheduled events or
just the events pertaining to the generation and distribution of this report.

Usage Report
Many devices from Oki Printing Solutions are capable of producing a Usage Report that is
generated and printed directly from the device’s operator panel. PSV can access this data
remotely if the Usage Report has been enabled on the device.
The Usage Report tracks black and color printed pages and displays page counts in
Letter/A4 size page equivalents (generally required for pay-for-print scenarios).
As an added convenience, supplies and consumable status is also displayed in the Usage
Report.
Note: With most Oki devices, the Usage Report feature can be disabled from the device’s
operator panel. If the Usage Report feature is disabled, PrintSuperVision will be unable
obtain the Usage Report page count information if the password is changed. If the default
password is used to set the Usage Report, then Usage Report has an option to enable the
Usage Report feature remotely.
An option is available in the Usage Report section of PrintSuperVision for “engine counts”
to be displayed. Engine counts are referred to as “life counts” of the device.
To generate a Usage Report,
1. Select Reports from the main menu and select Usage Reports from the drop down
box.

2. Select a group of devices
3. Indicate the desired file format for the Usage report.
Show Engine Counts is an option that displays life counter information but is not needed
if the Usage Report option is enabled in the device and is reporting page count data to
PrintSuperVision.
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The Collect Data option instructs PSV to obtain the latest information from the device
before the usage report is generated.
4. Click the Show button to generate a report.

The Configure Email button is provided as a navigational convenience and is not
necessary if your email system has already been configured.
The Send Email Now button sends the report in Email immediately to the recipient
indicated in the drop down box.
Click the Schedule button to send the report at predetermined intervals.
Click the Schedule Logs button for a running log of the Color/Mono Pages Report events
As an added convenience PrintSuperVison can enable the Usage Report option remotely
on most Oki devices by clicking on the Enable Usage Report Feature. Select a group of
devices and click start.
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Windows Print Job Logs
Another convenient feature in PSV is the ability to view individual print logs obtained from
the Windows print queue on client PCs where the PSV Agent is installed. The print logs
indicate the date the document was printed, the name of the computer used, the driver
used, the print queue, whether it was printed via USB or over the network, the name of
the document, and the number of pages.
The Print Job Logs report also provides the ability to summarize the number of pages
printed by a user and the number pages printed by particular device (only when the PSV
agent is used).
Since data is being obtained from Windows (and not the device) you can use this report if
you have non-Oki devices connected to PC’s that are running the PSV agent.
This feature works only if PSV Agent is installed in Windows XP or Windows 2003
computers.
To run a Windows Job log report, click Reports from the main menu and select Windows
Print Job Logs from the drop down menu.

Click the Collect Windows Print Logs check box and click Save. The next two
operations are optional but will help obtain more granularity in the data desired.
Click the down arrow in the Username drop down and select the desired Agent or leave
blank to obtain data from all agents. Click the down arrow in the Printer Address field
and select the appropriate print queue or leave blank for all print queues. Select desired
date ranges.
At this point you have the option to select any of the three choices: Sum by User, Sum
by Printer or Logs
Clicking Sum by User generates a simple list of the users that have the agent installed
and a corresponding number of pages printed by that user.
Clicking Sum by Printer generates list print queues, the type of driver used, the type of
print device used and the number of pages.
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Clicking Logs generates a report showing the username, the document name, and when
the document was printed, and the number of pages printed.

Finally, click the CSV option on any of these reports to export the data to excel for
further manipulation.

Printers Log Report
The Printers Log report collects status messages that are periodically displayed on the
device’s operator panel and saved in the device’s memory. It can be helpful to view a
history of all the messages the device has generated over a period of time when planning
a refresh or just looking at the performance of each device.
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The Printers log report allows you to select a specific group and/or device, a date range,
the types of messages and the ability to exclude certain messages (such as “online”,
“power save” and “data arriving”. You can also sort the logs by date / time of by device.
To run the Printers Log report:
1. Click Reports from the main menu and Printers Log from the drop down box.

2. Select All Printers, an individual group of devices and/or a single device from
the drop down menu
3. Select the desired date range
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4. Select the type of log to view or select All. Available options are: Errors, Statuses,
Oki Toners, Oki Toner and Page Counts, All.
5. The Exclude area allows you to filter out common messages that may be
unimportant to you like “paper out” “data arriving” and “online”. You can keep the
default filter words displayed or add and delete as you see fit. Make sure the words
or phrases are separated by a comma.
6. Sort the report by the date and time the log was registered or by individual device.
7. Click Show to generate the Printer Log report
Note: When All is selected in the View field, you have the ability to filter the log search
results further by selecting only the property that you are interested in.

For example, the Magenta Toner info property was selected. After clicking Show, all logs
that pertain to that property are displayed. Multiple fields can also be chosen by CTRL +
<field> or SHIFT + <field>.
When “Errors” is selected from the “View” drop-down list, specific control panel messages
can be excluded from the report by entering their text in the “Exclude” edit field. For
example, to exclude “Black Toner Low” messages from the report, you would enter “Black
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Toner Low” in the “Exclude” field. Messages in the “Exclude” field should be separated
from one another by a comma.

Device Job Logs Report
The Device Job Logs report allows you to analyze the type of print jobs sent to a device. It
provides the document name, the number of pages and sheets printed, the date and time
the document was printed and the username of the person who printed it.
Device Job Logs provide detailed reporting of print, copy, and scan use for a particular
device. This report is useful when detailed data is needed with respect to device use. The
report allows you to see totals by printer and by user. You can also view the data for
each individual job if that level of detail is needed.
It also lets you assign a “per-page” and “per-sheet” cost to each page and/or sheet to
quickly calculate the cost of printing. Pages represent a printed single side of paper and
sheets represent the physical piece of paper.
The Device Job Logs report is supported for the following OKI devices:
 B6200, B6300, B6250, B6500, B710, B720, B730, B930
 MB780, MB790, MPS5500mb, MPS5500mbf
 CX1146 MFP
 CX3535, CX4545
To configure and run a Device Job Logs report:
1. Click Reports from the main menu and select Device Job Logs from the drop down
menu
2. Click the Configure button and select the devices.
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3. The “Maximum parallel collecting” edit field allows the user to limit the number of
threads that PSV allocates for job log collection.
4. Enter a per page and per sheet cost if you would like PSV to calculate costs
5. Click Save
Some device configuration may be needed on the MB780/MB790/
MPS5500mb/MPS5500mbf depending on the level of detail desired. If copy jobs need to
be identified by user, then security on the device must be configured to require the user
to log in in order to use the copy function. Otherwise, a default device user is shown in
the report instead. Additional device configuration is needed for scan jobs to be reported.
The Off Device Customization Architecture (ODCA) must be enabled in the CX3535 and
CX4545 in order for PSV to collect job logs from these devices. This is done using
TopAccess and requires administrator log in.

To run a Device Job Logs report:
The user can filter the data by printer/printer group and by user. Selecting “Sum by
Printer” or “Sum by User” from the “Report” drop-down list results in summary data being
reported. To view detailed job data, select “Logs” from the “Report” drop-down. Each
print, copy, or scan job that has been collected from the device will be shown separately
in the report.
1. Select the appropriate PSV site, group, and user.
2. Select the option to summarize all logs by individual user, by printer or to just
produce a list of all job logs from each device.
3. Select a date range
4. Select Web if the report is to be viewed on screen, or CSV if you intend to import data
into Excel
5. Determine the number of entries per page
6. Click Show
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Meter Reading Report
The Meter Reading report shows color and mono page counters at the end of the selected
interval.
Counter values may not change for several days if the device is not being used.
The report takes into account any inactivity that occurs at the end of a period.
This provides a convenient way to see the counter values as of the end of a day, month,
or quarter.
For example, if 'Month' is selected for Interval, the report shows the counter values
collected before the first day of the current month. If Interval is set to 'Day', the report
shows the counter values collected prior to the current day.
In 'Interactive' mode, the report is shown on the screen. You also have the option to send
an email containing the report. The report is available in many formats selectable in the
Format dropdown list.
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Scheduled mode is used to configure periodic sending of the report as an email.
The last report date is saved as 'Reported Before', to remember when to send next
scheduled report.
"Process Now" generates the Meter Reading report immediately based on the displayed
report settings.
Show Email Logs displays a log of previous reports sent by email.
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Print Accounting
Accounting features that help manage compatible print devices are described in this
section. Not all OKI devices are supported.
The main features of PSV Enterprise Edition Accounting are:





Ability to collect detailed per user and per device job logs. The logs typically
include information such as the name of the document printed, who printed the
document, the number of pages printed, and the date/time it was printed.
Ability to enforce access control for individual users through the use of
quotas. Quotas enforce a limit on the number of pages a user can print each
month
Ability to import and synchronize user information from Microsoft Active Directory
or from CSV or XML files
Ability to generate reports that show data by user and device.

PSV collects accounting data from multiple sources. Using multiple sources allows PSV to
support a wider variety of print devices. The data sources include




Native firmware data from compatible Oki devices
o Print devices connected to network
o Devices connected to computers by USB (requires PSV Agent)
Web based accounting from some compatible print devices
Windows print logs from all print devices (requires PSV Agent). Note that Windows
print logs are limited to Windows XP and Windows 2000 OS.

When "full control" accounting is configured on a compatible OKI print device, each print
job needs to include an "AccountID" the print device has been configured to accept. If the
AccountID is not present or is not recognized as valid by the device, then the print job is
ignored.

Main Elements of the System
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PSV EE Web Server:
Manage print devices
Manage directory users
Username, AccountID, PrintID, CardID
(optional) connect to Active Directory to "sync" directory user's accounts
Import users' data periodically from AD
Communicates with Agents
Receive usage data and logs from Agents
Provide Directory Users info and other configuration data to Agents
PSV Agent
Communicates with PSV Server to get and send printer data
Receive and process print jobs from individual computers
Adjust print jobs to include AccoutID based on username
Hold print jobs or print directly
Monitor "authentication devices" such as ID Card Readers, Network KeyPad




Process received authentication info, find matching print jobs from identified user,
and send them to matching print devices
Manage "Power Save" mode on print device to reduce the time to print

The separation of features between the Server and the Agent is intentional. There could
be many agents connecting to the same server since the Agent is typically installed on
each computer acting as a print server.

Workflow
While the system has many features, typical use can be quite simple. The workflow is
based on managing the accounting features in the print devices. The typical workflow is:
 Configure Directory User accounts. Account management in a device is based
on the directory user accounts set up in the PSV EE database.
 Configure the Managed Print Devices. The option to collect job logs or to
control printer access is first defined in PSV server.
 Sync with selected print devices. The device settings specified using PSV are
then used to configure the print devices.
 Schedule periodic syncs with Active Directory and print devices. Changes in
Directory Users or desired device configuration must be communicated through the
system.
 Generate usage reports.

Configuring PSV Server Accounting
PrintSuperVision Server is a network print devices management tool with many features,
including those related to "Accounting" that are included in Enterprise Edition. Those
Accounting features are optimized for selected OKI devices and provide rich set of
management and logging options.
When used in combination with "Print Agent", PSV Accounting adds ability to track and
control usage of print devices, including "locking control panel" of MFP devices to control
access and usage.
Most of the time users of print devices and print services are already managed in Active
Directory, and PSV Accounting can leverage this by periodically importing "Directory
Users" from either Active Directory or CSV or XML files.
The PSV program also has user management for the program itself that is separate from
Accounting: PSV Users are managed in "Options => Users", and Accounting users are
managed in "Accounting => Directory Users". They should not be confused.
"Accounting => Managed Print Devices" is the tool for controlling and tracking usage of
print devices.
Data collected from print devices are available in "Accounting => Device Job Accounting
Logs", and monthly summary reports based on those data are in "Accounting => Print
Usage Report"
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PSV Server can periodically communicate with Active Directory, Print Devices, Print
Agents, and other PSV Servers, and all this is managed form "Services => Data
Synchronization" tool.

Options => Users
Access to PSV web application features is controlled by logging in to the web application.
Users that are members of the "Administrators" group have access to all program
features. Other users have access to only selected program features. User authentication
can be configured to use Windows authentication (Active Directory when computer is in a
Domain), or username and password can be stored in the PSV database. This choice of
authentication method is done from the PSV Setup tool.
Managing PSV Users is done from Options, Users menu.

Accounting => Accounting Options
The Accounting system in PSV requires some configuration to make full use of the feature.
This is done on the Accounting Options screen.
"Mono Page Price", "Color Page Price", and "Scan Page Price" specify the unit cost for
reporting the cost in addition to the page counts in the Print Usage Report.
The "Valid Ports" filed is used to specify which ports to collect print logs from. It can be
used to prevent print logs associated with custom print queues from being
reported. Printing to a file would be an example. In most cases, you want to include
"IP_" and "USB" in the "Valid Ports" field. This indicates you are interested in print logs
from network printers and USB-connected printers respectively.
"Color Quota", "Mono Quota", and "Scan Quota" define the default maximum number of
pages that can be printed or scanned in a month by individual users. These default
quotas are used when no quota has been assigned to an individual.
The "ServerID" is used to identify a particular PSV instance. This ID is sent to the devices
that are being managed by PSV server. A device can only be managed by one tool at a
time, and devices use this ID to prevent other tools from accessing it.
Which models should be considered color models and which should be considered mono
models needs to be configured. The "Color Models" and "Mono Models" edit fields are
used for this purpose. The models in each field should be separated by a comma.
The "Color Models", "Mono Models", and "Valid Ports" fields affect Windows job logs
only. Logs received directly from a device are not affected by these settings.
Several other options can also be configured on the Accounting Options screen.
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Message to be presented to user on the computer where PSV Agent is installed at
login.
Message to be presented to a user if he/she has exceeded his/her print quota.







(Optional) Default Color and Mono print quotas, used when a print quota is not
defined for an individual user.
Default Windows "Domain" to be added for device job logs.
To change web password in Managed devices when they are synched with PSV
Database. If this checkbox is checked, device password will be changed to the
password specified in the "Common Web Password" field.
To allow same number to be used for logging in to Device and releasing secure
Print job.

The Save button saves the currently configured settings to the database.

Accounting => Directory Users
The PSV Accounting system maintains a separate database table of users called "Directory
Users". This set of users is distinct from "PSV Users". Accounting users are anyone who
will be using one or more print device and are typically imported from Active Directory.
While the number of "PSV Users" is usually relatively small consisting mostly of network
administrators and operators, the number of "Directory Users" may be quite large.
The "Print Agent" gets the "Directory Users" from its designated PSV Server. Print Agent is
periodically synchronized with PSV Server to ensure its list of Directory Users is current.
When the Agent is running on the same computer as PSV Server, that synchronization is
done immediately. Changes to Directory User data is immediately sent to the local Agent.
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When the Print Agent is running on a separate computer, users are automatically
synchronized at fixed periods or by requesting an update using the Agent Setup tool.

Adding new Directory Users
Each person using the Print Agent solution must have an account set up in the PSV
database.

Sync with Active Directory
Relevant user data such as name, account ID, and print ID can be imported from Active
Directory using PSV. From the Services menu select "Data Synchronization." Then click
the "Sync AD Now" link.
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Import from a CSV File
If card readers are being used for user authentication, the card ID numbers should ideally
be included in the CSV file. The file is then imported into PSV by selecting "Export /
Import Data" from the Tools menu.
To find expected format of data for "import", use the "export" option first to generate a
sample file.
1.
2.
3.
4.
5.

Select "Export / Import Data" from the Tools menu.
Select "Import Directory Users" from the drop-down list.
Select the appropriate Encoding option from the dropdown list.
Click the Browse button to select the CSV or XML file containing the Directory
User data.
Click the Upload button to import the data.

Manually Adding Users
Users can be manually added to PSV by selecting Directory Users from the Accounting
menu. Then, click the Add Directory User button.
To be able to use "Keypad" authentication and in cases where "full print device
management" is configured, each user must have an "Account ID" assigned. Account ID
needs to be unique for each user.
To be able to use "Card Reader" authentication, a "Card ID" has to be assigned to a user.
When the Print Agent is running on the same computer as the PSV Server, the Card ID
can be scanned directly from a designated card reader and then automatically populated
on the "Edit Directory User" page. In the SPConfig.xml file, the <CardReader> entry
must have the signUp="true" attribute.
The procedure is:
Select a user from the Directory Users page by clicking in the Edit column of that user
 Let the user scan the card on the designated card reader
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Enter question mark ("?") in Card ID field, and click "Save" button at the bottom of
the "Edit Directory User" page

The Card ID is then obtained from the reader, saved to database, and synchronized with
the local Agent.

Accounting => Managed Print Devices
A managed print device is one that has been configured by PSV for accounting. The
option to collect job logs or to control printer access is first defined in PSV server. The
device is then configured with the desired setting. This feature is available only for a
select group of printers.
The list of supported printers is displayed in the Intro tab.
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The Managed Print Devices page lists the devices that are currently being managed by
PSV. You can change the configuration of a specific managed device by clicking in the
Edit column of the appropriate row. To add a printer to the list of managed devices, click
the "Add Device" link. Ensure that the device is up and is not in error state which will
inhibit managing the device.
Clicking the Sync Now link causes the device to be synched with the configuration data in
the PSV Database. Configuration changes made in PSV do not take effect in the device
until they are synched using Sync Now. The synchronization can be scheduled by clicking
the Schedule tab.

PSV EE supports several options with respect to managing printers. Logging is the most
basic option. When logging is enabled, print logs are collected from the device so that
print usage can be tracked. No restrictions on printing or copying are enforced. Logging
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MFP is the same as Logging except the user must login through the MFP console using an
account ID in order to copy. There are no restrictions when printing. When "full control"
accounting is configured on a compatible OKI print device, each print job needs to include
an "AccountID" the print device has been configured to accept. If the AccountID is not
present or is not recognized as valid by the device, then the print job is ignored.
Adding AccountID to print jobs can be done in two ways:



Installing and configuring "Job Accounting Client" tool on each computer.
Configuring a print server computer with PSV Agent SP (Secure Print).

This page shows the current device management settings for a specific device. "None" is
used to indicate that the device should not be managed. If the PSV database has been
synched with Active Directory, the list of user groups will be shown in "Add" dropdown. A
Device can be assigned to a number of such groups, by selecting that group and clicking
the "Save" button.
After the desired configuration options have been set, click the "Save" button. This saves
the current device settings to the PSV database. Saving the settings to the database does
not mean the device is configured with these settings.
Note that the device management settings currently set in the device are shown at the
bottom of the page. If the device is currently managed by any other PSV server, it will be
indicated here.
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After the desired options have been saved in PSV, the configuration still needs to be
loaded to the print device in order to take effect. You have the opportunity to do this
immediately after saving the configuration for a particular device. A "Sync" button will be
shown at the bottom of the page. Clicking this button causes the device to be synched
with the configuration data in the PSV database.
Print devices maintain information regarding what server it is currently using, and will
prevent other tools from accessing it. PSV provides a way to "take over" a print device
managed by another server.
Select the "Take over if device is managed by another tool" checkbox prior to clicking
Sync.

Clicking the Managed Printer Users link shows the list of users who have been
configured for the device. A device must be configured with user data if Full accounting
control is used.
The "Configured" column indicates if an Account Number is assigned to the user.
The "In Device" column indicates if user has been synched with and is present in device.
"Last Sync" shows when the account was last synched with device.
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Clicking the Changes Log link displays a log of configuration changes made to the
managed device.

159

Clicking the "Sync Log" link displays a history of when job log data was retrieved from the
device.

Clicking the Sync Now link causes the device to be synched with the configuration data in
the PSV Database. Configuration changes made in PSV do not take effect in the device
until they are synched using Sync Now.
Clicking the "Configure" link takes you to the Configure page. From here you can
configure the password for the device provided the current password is present in the PSV
database.

Accounting => Device Job Accounting Logs
The Device Job Accounting Logs page provides reporting on PSV accounting data. The
user can filter the data based on printer, user, and date.
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When the "Logs" option is checked, the report provides detailed data on each print job.
When the "Sums" option is checked, the report includes two tables of data. The first
shows the print, copy, and scan totals for each user broken out by device. The second
shows the print, copy, and scan totals by user.

When the "Color/Mono" option is checked, the same two data tables are generated, but
the copy, print, and scan values are broken out between color and mono pages.
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Accounting => Directory Printers
PSV server makes a list of all "Directory Printers" that is based on the Windows print
queues. This is a basic assessment of printing devices based on the printer queues
defined on computers where the Agent is installed.
Based on the information from the printer queues, the Agent attempts to communicate
with print devices. The data received from these devices is sent to PSV server and saved
to the database. The server can then determine which are "real" devices currently
"responding". Which are potentially "valid" devices with valid port types (i.e. USB or IP,
based on configuration on "Options" page), and which most likely are custom print
queues (configured to "print to file" for example).
For each device there is a column "Job Accounting" that is ON or OFF for compatible Oki
devices. Links to Windows and Device job logs for each printer are provided.
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Accounting => Print Usage Report
PSV collects accounting data from multiple sources. The monthly summary reports based
on the accounting data collected from printing devices in Device Job Accounting Logs is
shown in this report. If the unit costs for color and mono pages are entered in the
Accounting Options, the price is also shown. The report can be filtered for individual users
or for specific periods of time.
Since there are two separate sources of print logs (Windows logs and device job logs), the
program determines if the device job logs are available for a given printer. If they are,
then the device job logs are used for that printer. Otherwise Windows logs are used.
Note that Windows Job Logs are available only if PSV Agent is installed on a Windows XP
or a Windows 2003 computer.

Services => Data Synchronization
In most enterprise environments, the user list is maintained by the IT Department usually
in Active Directory. Computers running PSV can be configured to synchronize the user
list with Active Directory.

Managed Device Data Synchronization
Devices configured to be managed need to be periodically synchronized with the PSV
database. Data is synchronized both from the device to PSV and from PSV to the
device. First, the current usage data needs to be collected from the devices and stored in
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the PSV database. Second, changes to configuration settings and directory users need to
be sent to the managed devices.
To facilitate the setup of Directory User information, the data can be imported from Active
Directory. This can be done automatically at scheduled intervals or only upon
demand. The "Sync AD Now" link will synchronize Directory User data with Active
Directory. Click the "Sync AD and Devices Now" to synchronize Directory User data with
Active Directory then configure managed devices with that data.
"Custom" fields are stored in one Active Directory field as name=value pairs, one per line.
The default field name is "info", and an Active Directory administrator can create a custom
field in Active Directory for this purpose.
The Data Synchronization screen is accessed through the Services menu.

Data synchronization is scheduled using the "Start synchronization at" and "Data Sync
Interval" fields. The "Start synchronization at" field defines the starting time to run
synchronization. It is expressed in 24-hour notation with midnight being 00:00. The
"Data Sync Interval" field defines how frequently synchronization will be done during the
day. If the value is 1, then synchronization is done once per hour. If the value, is 24,
then synchronization is done only once per day.
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Synchronization with Active Directory will only be done if the "Active Directory
Synchronization" checkbox is checked. Likewise, configuration and user data will only be
sent to managed devices if the "Device Synchronization" checkbox is checked. The
"Device Synchronization" checkbox must also be checked in order for print logs to be
collected from managed devices.

User Info from Active Directory
If additional user data is to be configured for the Active Directory users, IT administrators
can use the Windows Server tools.
Editing user data in Active Directory (AD) can be done using the standard Windows Server
"Active Directory Users and Computers" tool. Right click on a selected user and select
"Properties" from the menu. To make configuration easy, the default is to store
accounting information into an existing "info" text field of the "user" object. This is visible
on the "Telephones" tab of user properties in AD. The field is labeled "Notes".

A custom AD field can also be used, for network admins that are familiar with using
custom AD schemas. In such cases the name of the AD field needs to be specified on PSV
Data Synchronization page (Active Directory custom property field).
The format of data in the AD field is Name=Value with each pair on a separate line. Not all
name-value pairs shown below are required. For example, you could specify only the
value for PSV_AccountID.
PSV_Quota_Color=1000
PSV_Quota_Mono=2000
PSV_Quota_Scan=3000
PSV_PrintID=1234
PSV_AccountID=123456789
PSV_CardID=56789
PSV_Status=0
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Services => Print Agents
When PSV Agent is used to authenticate and manage the print devices, the status of the
Agent can be viewed from PSV server.
When the Agent is running on the same computer as PSV Server, the current status of the
Agent and management of recent print jobs can be done by selecting "Print Agents" from
the "Services" menu.
The "Agent Status" information includes the status of all configured authentication devices
and the "Print Listeners" that receive incoming print jobs.

Clicking on "Print Jobs" provides a list of all print files received in the last 24 hours. You
have the option to Cancel print jobs that are not printed yet.

When the Agent service is not running an error message is displayed. If the Agent is not
installed on the same computer as PSV Server, then no options are visible on this page.
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Options => Features Access Rights
In enterprise environments, all the print management jobs may not be the responsibility
of the IT administrator. The IT administrator can delegate some of the tasks to others
without providing complete administrator access to PSV.
Some features available only for PSV users that are members of the Administrators user
group could selectively be made available to other PSV users. Select "Options | Features
Access Rights" from the menu. It is possible to "Add" a user to a selected feature or
"Remove" them from that feature using this page.

After this, the selected users will see new options in the program menus after logging into
PSV.
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Adding Device Attribute Data
PrintSuperVision allows a user to attach attributes to a device to help locate it, to
determine who is responsible for maintaining it, etc. The added attributes are not
reported by the device, so as a user you must manually enter data into the attribute fields.
The attributes can also be added by using Import/Export attributes from “Tools |
Export/Import Data” screen. The attributes can also be added to PSV when you use
“Import Printer Addresses & Attributes” option in Printers menu.
To add attribute data
1. Select Printers from the main menu
2. Select Printers from the drop down menu
3. Click on any status icon (printer icon in the left margin) to link to a print device’s
status page.
4. Click the Attributes button and click Edit
5. Enter data in any of the Attribute fields and click Save at bottom of the screen.

The user-entered attribute information can be included in several reports if the same
Attributes are selected from the Configure Properties and Attribute section listed under
Reports in the main menu.
Note: An Admin can also import a CSV file that already contains the desired attributes
associated with many devices at once.
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To import a CSV file:
1. Click Printers from the main menu
2. Select Import Printers and Attributes
3. Browse for an appropriate CSV file, Indicate how the fields are delimited and click
Import.
Another way to import the CSV file is:
1. Click Tools from the main menu
2. Select Import / Export Data
3. Select Import Attributes from the dropdown list
4. Browse for an appropriate CSV file, indicate how the fields are delimited and click
Upload.
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Monitoring Locally Connected Devices
PSV allows you to monitor Oki devices that are connected to laptops or desktops via USB
rather than connected directly to the network.
Local monitoring is achieved by installing the PSV Agent on each client that has a locally
connected Oki device. The agent consists of a Windows Service that monitors local print
devices connected through USB ports. The PSV Agent periodically collects management
data from the device and sends it to a PSV Enterprise server. The agent reports alert
conditions, supply levels and page counts just as if the device was directly connected to
the network.
The agent supports all popular Windows operating systems including Win XP, Vista,
Windows 7, Windows 8, Server 2003, Server 2008, Server 2008 R2 and Server 2012.

Introduction to PSV Agent
PrintSuperVision Agent “USB” Edition supports monitoring the status of compatible print
devices connected to a computer via an USB port. Print devices connected to a USB port
are continuously monitored so the Agent detects status changes almost immediately as
they happen. Device status can be written to a log file as it is received. Status updates
can also be communicated to PSV server by the Agent using HTTP.
The Agent USB runs continuously as a Windows Service and can be used to:
 monitor the status of USB-connected print devices
 collect and store status data as it appears in the device
 communicate device status with PSV server

Main Features
PSV Agent is a tool that can help monitor print devices connected to local USB ports. This
tool is intended to help administrators, not the end-users. It is not a “local status monitor”
tool.

PSV USB Agent Installation
Double click on the PSV USB Agent install file. Follow the on screen instructions to install
the PSV USB Agent.
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Once the installation is completed, click on “Close” button to launch the PSV USB Agent
Setup program.

Configuring PSV USB Agent
The Setup program is where various program parameters are set. The Setup program is
automatically launched by the installer. The Setup program is also available from the
Start menu in the PrintSuperVision Agent program group.

Options Tab
The Agent is able to communicate device status and additional printer data with the PSV
server application. The configuration required to enable this is done on the Options tab.
The Options tab contains a field to specify the Processing Interval. This setting controls
how frequently the Agent updates the list of USB-connected devices it is monitoring. It
will check if any new devices have been connected or if any previously connected devices
are no longer responding. If you connect a new device to the machine where the Agent is
running, and you want the status to be immediately monitored, then you will need to stop
and restart the service.
The URL of the PSV server is entered in the PrintSuperVision Service URL field (for
example: http://11.22.33.44/printsupervision/). This is the URL the Agent will send
device data to. The connection with the server can be verified by clicking on the “Test
URL & Save” button. The results of the operation are displayed in the message window at
the bottom of the Setup program.
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Service Tab
The Service tab allows you to stop and start the Agent service. The current status of the
service is shown as either Running or Stopped. “Refresh” allows you to view the current
status of the Agent service.

Click on “Show Service Log” to view the log of the actions taken. The service log can be
archived by clicking the “Archive Service Log”. To clear the data shown in the bottom part
of the Agent, click on “Clear”.
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About Tab
The About tab displays version and edition information about the Agent.

Installing PSV USB Agent From a Command Line
PSV USB Agent installation can be automated by running the installer from a command
line. When this is done, the required program parameters are provided through command
line arguments. The installation completes without any additional user interaction. The
following command line arguments are supported:
/URL=
Specifies the URL of PSV Server. This is the URL the Agent will send device
data to. The URL must be enclosed in double-quotes /URL=”http://123.45.67.89/PrintSuperVision”. This argument is required.
/INTERVAL=
Controls how frequently the Agent updates the list of USB-connected
devices it is monitoring. This argument is optional. If not provided, then 60 is used by
default.
/S
Runs the installer in silent mode. This argument is required for the installer to run
without any user interaction.
Installation can be automated using network login scripts or some other remote desktop
management tool.
This screenshot illustrates the command line syntax for installing PSV Agent USB.
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Uninstalling PSV USB Agent
The Uninstall option is available from the Start menu in the PrintSuperVision Agent
program group. The program can also be uninstalled from Control Panel | Add or
Remove programs.

Installing the PSV Agent Using PSV Director: Option 2
The Agent can also be installed remotely using the PSV Director application. PSV
Director is a tool for Windows domain administrators that remotely installs, upgrades,
uninstalls, monitors, and configures the PSV Desktop Agent on computers within a domain.
The Director can also collect information about printer queues, drivers, and ports on either
a single computer or all computers in a domain.
If the PSV Director application was selected for installation when you installed PSV
Enterprise, the application will be located in: Start / All Programs / PrintSuperVision /
PrintSuperVision Director.
1. Click PrintSuperVision Director and open the application
Navigating PSV Director
The tree view on the left side of the main window lists all visible domains and computers
in the Active Directory. To view an up to date list, click the Refresh button, located
directly above the tree view. Alternatively, right click a domain and click refresh, to
update just the computers within that domain.
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PSV Agent Tab
This tab indicates whether or not the PSV Agent is installed on the currently selected
computer. If it is installed, you can check the service status and make configuration
changes. Additionally you may install, upgrade, or uninstall the PSV Agent from this tab.
To install the PSV Agent using the Director:
1. Indicate the interval of time that the agent should contact the PSV Server
2. Enter the IP address of the PSV Server that the Agent will contact, along with the
appropriate port number and Virtual Directory name
3. Click the Change button and browse for the Agent Installer which is an .exe file
4. Click the Install / Upgrade button to install the agent on all selected clients
After installing the Desktop agent you can return to the same PSV Director screen to
upgrade the Desktop Agent or make any necessary changes.
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The Print Queues Tab
The Print Queues feature in PSV Director is designed to display available print queues
from all or individually selected client computers. It also provides an alternative method to
discover devices.
Click the Show Queues button to refresh the list
Click the Discovery button to discover the network printers on this machine. Only HTTP
communication is supported for this feature.

To add devices to the PSV database, enter the location of the PSV server, the port number
and the virtual directory name:
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Click the OK button
PSV Director will communicate with the PSV Server and add newly discovered devices to
the PSV discovery database. It will also indicate if a device is already in the database.
Note: The PSV Director relies on a service packaged with Windows, called the "Remote
Registry Service". In Windows XP and Windows Server 2003, this service is enabled and
started by default.
In Windows Vista, Windows 7, Windows Server 2008/R2, Windows 8, Windows Server
2012, the service is not started by default. So in order for the PSV Director to be able to
access computers running these operating systems, this service must be started on each
of the remote computers.
It is recommended that the "Startup Type" for this service be set to "Automatic" on each
of the client computers.
PSV Director is just one tool that can be used to “push” the Agents out to remote clients.
If your IT organization uses your own tools to install and update client computers, you can
certainly use those tools to install and maintain the PSV Agent as well.
The Agent is not included in the PrintSuperVision Enterprise Edition installation package
but can be downloaded separately from www.okidata.com

PSV Assistant
For Parallel Port connected Oki devices you will need to use the PSV Assistant. The
Assistant is available as a download from www.okidata.com.
The Assistant is a separate application much like PSV Agent that allows you to view
printer attributes and supplies status from locally connected Oki print devices that are not
directly connected to the network.
PSV Assistant supports the following Windows operating systems: Windows XP, Vista,
Windows 7, Server 2003, Server 2008 and 2008 R2.
The Assistant is installed on users’ desktops or laptops and periodically sends supplyrelated data such as page counts, toner and drum life status to the PrintSuperVision
Enterprise server.
PSV Assistant can be installed individually at each desktop/laptop or can be pushed to
each PC by using command line installation. To install PSV Assistant silently, use the
syntax listed below.
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Note: PSV Assistant requires providing the URL of the PSV server as a command line
parameter during installation.
<assistant.exe> /U=<serverurl>
For example:
/"
(ex. /U=”http://123.45.67.89/PrintSuperVision/”)
/S
Silent install mode
/N
Do not create shortcuts, including a desktop icon and start menu link (shortcuts are
created by default).
/I
Data collection interval in minutes (default value is 60).
An example is:

If you are not installing via command line instructions and you are installing locally, follow
these steps:

Click Next or check the appropriate boxes for available options
After installation is complete, open the PSV Assistant application and highlight the print
device that is most often used from the list of available device drivers.
Click Add in the Monitored Printers section. Your device will be added (you can remove
the device at any time by clicking the Remove button.
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Click the Options button
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1. Select the desired interval level which controls how often PSV Assistant contacts the
PSV Server.
2. Set the option to use HTTPS if desired
3. Click the option to log (save) all messages if desired
4. Select the desired client proxy configuration
5. Click OK
If you allow your users to access PSV Assistant from their desktops, they can click the
Reports On-Line button to view supply status, page counts, etc.
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Performing Day to Day Tasks
Depending on the degree of automation set up during initial configuration, PSV can
essentially run in the background on autopilot and only alert you when a device needs
attention, or to deliver reports. But there will always be situations where you need to
access PSV to check the status of a device, check the level of supplies or to manually run
reports.

Viewing Device Status
To view a list of devices that was previously discovered:
1. Select Printers from the main menu
2. Click Printers, My printers, or Near Me.
Selecting “Printers” provides a list of all discovered devices. “My printers” displays only
the devices that you previously added to the My Printers group.
Selecting “Near Me” automatically displays the print devices that share similar IP
addresses with the computer you are using to access the PSV server. The Near Me option
cannot be customized.
When viewing a long list of devices, click the Refresh button to obtain the most recent
status information on all devices displayed.
You will notice after clicking Refresh, a teal color moves from line to line indicating that
the device status is being refreshed. Notice too that the printer icons in the left margin
are now color coded to quickly determine the status of the device.
Green indicates that the device is running fine, there are no Alerts and no supplies
need to be ordered
Yellow indicates that an alert has been received, an error has been detected or a
lower level (less critical) action needs to be taken
Red indicates that a critical error or serious Alert has been received and immediate
action is required
The information icon indicates an event has occurred, such as toner or drum
replacement, cassette drawer is open or the device is printing. Generally no action
is required when the information icon is displayed
The “no access” icon indicates that the device is disconnected from the
network, or is not responding
At any time while viewing the list of devices you may click on the status icons in the left
margin and link directly to the status page of the individual device.
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Quick Search
A convenience feature added to PSV 4.0 allows quick access to all PSV sites, groups,
individual devices and status codes from one main area. You also have the option to
select several predefined sets of properties as well as how the information is viewed.
1. Click Printers from the main menu and select Printers from the drop down box.

2

4

3

5

6

7

2. Select the appropriate PSV site from the drop down box
3. Click All Printers or the appropriate group name. The devices associated with that
group are instantly displayed. You may also use the Search option to locate a group.
4. Click All to generate a list of all model devices within a group or click on the individual
model name to show just that device
5. Click all to generate a list of all status codes, or select an individual status code for
individual devices that are currently displaying that status code
6. Select the desired set of predefined device Properties to display or select Local for
only the properties that you have previously indicated
7. Click List or Icons depending on your viewing preference
Note: You may also choose multiple selections at a time by using the standard Windows
click sequences (hold down Ctrl key and click).

Changing the Device Properties Displayed
At any time, you may customize the device properties displayed on the “Printers Page”,
with the exception of address which is always displayed. To add or subtract properties:
1. Select Printers from the main menu and select Printers from the drop down menu
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2. Click the Properties button
3. Select the device properties that you wish to display from the “All Properties” list and
click Add

4. Reposition the order of the properties according to the viewing order by selecting the
property and clicking the Up or Down buttons
5. Click Save to save the “Local” set of properties
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Additional Configuration Settings
The settings page provides several configuration options explained below:
1. Click Options from the main menu and Settings from the drop down box
2. Make appropriate settings
3. Click Save

Site Information: Site information such as Site Name, Location are included in some
email reports
SNMP Get Community: Is the name of the SNMP Get Community. Default is public.
SNMP Set Community: Is the name of the SNMP Set Community. Default is public.
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SNMP Get Timeout: Is the maximum time PSV will wait in seconds to obtain a value
(via SNMP) from any device. Select 1 to15 seconds
SNMP Discovery Delay: When discovering a large number of addresses, depending on
the network bandwidth restrictions, it may be preferable to add a SNMP delay between
discoveries using SNMP Discovery Delay setting.
HTTP Timeout: Sets the time delay between HTTP requests sent by PSV when “Configure
Print Devices” feature is chosen.
Status Icon Timeout: The Printer status icon
will be displayed in gray if the
device status has not been updated within this timeout period in minutes.
Auto Status Refresh: The number of minutes PSV waits before starting a status refresh
when viewing a list of devices. 0 = no auto refresh
Retry Interval: Sets the interval time between SNMP request retries
Retry Maximum Wait: sets the time after which the SNMP request will not be sent again.
Old After: Values after the specified interval will be shown in gray.
Auto Set Online: Checking this box instructs PSV to try to switch an Oki device from
Offline to Online during auto status refresh. This feature is only available for select Oki
devices. Note: The Oki device has to be set to SNMP v1 to support this feature. The
setting is located in the device’s web page.
Refresh Color: When viewing a list of devices (by clicking Printers from main menu,
then Printers from the drop down box), the background color of refreshed fields will be
displayed in the color you choose when the value of the field has not changed. Set to
White if no colors are desired.
Changed Color: Sets the background color of refreshed fields when the values of the
fields have changed. Set to white if no colors are desired.
Include Manufacturers: Allows you to include only devices from specific brand names
when generating a list of devices or during discovery. In other words, it filters out all
devices except from the manufacturers named.
Exclude Manufacturers: Allows you to selectively exclude devices based on brand name
when generating a list of devices or during discovery.
Use DNS Addresses: Identifies devices using DNS addresses, when available, instead of
IP addresses. Activating this feature will convert IP addresses to DNS addresses on all
active printers in the database.
Read Only Mode: Stops all network communications from PSV. This can be set or reset
from PrintSuperVision Setup utility.
Collect Device Job Logs: Check this option to collect Device job logs.
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Changing Languages
The language selected in PrintSuperVision can be changed at any time without the need to
install language-specific versions of the application. To change language
1. Select Options from the main menu and Locale from the drop down box
2. Click the appropriate radio button
3. Click the Save button
Caution: The new language will be displayed as soon as the Save button is clicked. Take
precautions to know how to get back to your native language if you are unfamiliar with
the language just selected.

Downloading Oki Drivers
For convenience, PSV provides a built in search mechanism for Oki drivers and quick links
to download a specific driver right from the PSV application. This feature saves time by
eliminating the need to navigate, locate, and download drivers from www.okidata.com.
Note: The driver search and download feature is only available when United
States/English is selected as the Locale during setup.
To search and download an Oki driver:
1. Select Tools from the main menu and Drivers from the drop down box.

2. Select the model, OS and Language of driver you are searching for
3. Click Go
4. Click the link to the desired driver in the left column and Run or Save the driver
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Sending Files / Updating Firmware from PSV
PSV has a "Multi File Printing" tool for sending multiple print files to multiple print devices.
The tool can also be used to update firmware on a fleet of printing devices deployed
remotely.
There are options to make the update as safe as possible, to update multiple print devices
in parallel, and to schedule the update after normal business hours.
Note: Caution is needed when performing firmware updates because in some cases an
incomplete firmware transfer may render the print device unusable.
In addition, installing firmware revisions in a specific sequence is also important (you may
have to update to an intermediate firmware version before you can update to the version
you want installed on the device).
Before sending a firmware file to a print device, please make sure to get
complete information from Oki Support. When used properly, the firmware updating
feature in PSV can save significant time and effort.
Preparation
Print devices first need to be discovered or imported into the PSV database. To obtain the
correct firmware version and instructions about the required upgrade order please contact
Oki Support.
You will need the currently installed version of firmware in all print devices being
upgraded. This is available in PSV, by adding “CU Firmware” in “Properties Views” Select
“CU Firmware Version” from the list on the left, add “Add” button, and click “Save” button.
Then, return to the “Printers” list and click the “Refresh Data” button.
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Firmware Upload
The first step is to “upload” the firmware file to the PSV web server. To do this, select
Multi File Printing from the Tools menu. Then, click the Upload Print Files link on the
Multi File Printing page. The file must have a .prn extension in order to be accepted by
PSV server. Rename the file if necessary. It is recommended that only one file be
uploaded at a time. Make sure to use a genuine firmware file received from Oki Support.

Microsoft’s IIS may limit the size of a file being uploaded. An error message similar to
“Maximum request length exceeded” may be an indication that a file exceeds this limit. If
you encounter this problem, IIS can be configured to accept larger files, or the files can
be copied manually to the PSV server machine. PSV stores uploaded files to the PSV
installation location in a folder called “Upload”. Program Files\PrintSuperVision\Upload.

Configure Options
Next, select a firmware file to use for the upgrade. You can optionally specify a printer
group, a printer model, and a firmware version to control the set of devices that receive
the upgrade. Print devices in PSV can be arranged into “Print Groups” to help manage
related devices. A print group can be used so that the firmware update is applied to all of
the printers in the group. The “avoid duplicate sending” checkbox and “firmware
upgrade” checkbox are available as additional options. The “firmware upgrade” option
instructs PSV to wait for device to reboot, and check firmware version after sending file.
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The tool has option for including and excluding print devices based on the printer’s current
status. This is important since sending a firmware update to a print device in an error
state can cause problems!
The “Avoid Duplicate Sending” option is a convenient way to send the firmware only to
devices that haven’t received the update so far. The program keeps a log of previous
device updates, and can avoid sending the same file again. That way, you can run the tool
multiple times with same group of printers, until all of them are updated.
Click the Next button to proceed to the final confirmation page, or to save the selected
options for later “Scheduled” execution.
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The tool provides selectable options for
 Buffer size: Default is 10,000 Bytes. This affects tracking progress. On local
network it could be larger, on remote can be less, but less that 1000 would make it
much slower.
 Maximum Threads: max number of print devices that will be updated at once.
Use with caution. Start with small number (i.e. 3). You can increase up to 10 if you
have a fast computer (i.e. quad-core). Parallel sending is quite robust, but the
computer needs to be fast enough to be able to handle parallel connections
 Enable IP Filtering: Available only if "Firmware Upload" is first checked". This is
an advanced feature to restrict print access to print devices before sending the file,
and removing the restriction after the file has been sent. The restrictions are
removed even if sending the file fails. This option is currently limited to B6500
model only.
Clicking the Send button starts the upgrade.

Firmware Upgrade
The tool provides a visual indication of progress while sending files to print devices. This
includes the elapsed time and estimated remaining time. The same options are available
when Multi File Printing is "Scheduled". Scheduled sending is done by PSV Engine
service, and will not be interrupted by timeouts.

Multi File Printing Log
PSV maintains a “Multi File Printing Log” where it records the sending of files to print
devices. The log includes details such as the size of print document, total number of bytes
sent, and total time of sending. The report is accessed by clicking the “Multi File Printing
Log” button on the “Multi File Printing” page.
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B6500 IP Filtering
IP filtering provides additional protection against any failure of the device when firmware
is being updated. During that period, the device will accept data from only the IP
address that is configured. It is recommended to use this option. For the OKI B6500,
this feature is available from PSV.
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Creating a Maintenance Log / Managing Supplies
Inventory
The maintenance Log feature allows you to keep track of services performed on individual
devices and acts as tool to help keep track of supply items kept in your inventory
including the price you paid for the item. All of the data in this area must be entered by
the user.
1. Select Tools from the main menu and Maintenance Log from the drop down box.

The screen shown above is used for searching for specific supply items and service calls
that have been previously entered. Add various supply items and service calls before
attempting to generate a List.
2. To add supplies to your electronic storage cabinet, click the Supplies button.
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3. Enter the Brand of device, model name, SKU of the supply item and select the type of
supply from the drop down menu. You can even enter the quantity that you are
adding to inventory and price paid for the item.
4. Click Save
You may return to the electronic storage cabinet at any time to edit the items, reduce the
amount of inventory or delete the supply item. Click the brown box icon in the edit
column to edit supply items.
To record a service call:
1. Click the Maintenance Log button and you will return to the main Maintenance Log
screen.
2. Click the Add Note Button

3.
4.
5.
6.

Select the appropriate device from the drop down list
Enter the date the service occurred, add optional comments
Enter the cost of the service
Click Save and a record of the service call is saved.
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Public Web Services
PrintSupervision offers developers sample test applications and function calls to integrate
PSV with other Enterprise applications.
1. Select Services from the main menu and Public Web Services from the drop down
box.
Six samples test applications are provided and explained below:







197

AboutVersion: Shows the PSV version number
Address2 printers: Provides the details of a specific device
GetProperties: Shows device properties
Printers: Provides a list of the devices along with device details
Status Codes: Provides a list of Alert Status Codes, their descriptions, and their
severity level
StatusSeverityNames : Shows available status name choices such as OK, Info,
Warning, Error

